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About This Guide

Creo View is PTC’s primary enterprise Visualization application. It provides
flexibility to view CAD files and their associated images and documents as a
standalone client or in the context of a Windchill server. This guide describes how
to generate and configure licenses, and how to install and maintain the Creo View
client. A section for system administrators on deploying Creo View describes
performing a silent installation and customizing the installer.
System administrators who are performing advanced deployment tasks for Creo
View must be experienced in application installations and must have a good
understanding of operating systems.

9

How to Use This Guide
This guide supplements the descriptions in the installer and provides installation
prerequisites, instructions, and reference information. To generate or update
licenses and then install or reconfigure Creo View, see the following chapters:
Chapter
Overview

Role
All users

Information
Describes the materials in your
software shipment and lists the
prerequisites for installation.
Quick-Start Installation Existing users
Describes a quick-start
approach for users who have
previously installed license
management and product
software.
Obtaining and
System administrators Describes how to generate or
Configuring Licenses
This chapter does not update licenses for Creo View
apply to users of Creo and how to install PTC License
View Lite and Creo
Server.
View Express.
Installing Creo View
All users
Describes a simple installation
process for Creo View.

Starting Creo View and All users
Modifying an
Installation

Describes the steps to start Creo
View and the procedure to
uninstall the software.

Deploying Creo View
and Customizing the
Installation

System administrators Describes methods for
deploying Creo View and
outlines strategies for silent
installation.

Updating an
Installation

All users
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Describes how to update Creo
View on your system.

Related Documentation
The following documents on the Reference Documents page may be helpful as
you proceed with the installation:
•

FlexNet Publisher License Administration Guide that discusses the third-party
license management software for distributing Creo licenses

•

Standalone PTC License Server that discusses the installation of the lmadminbased PTC License Server

For information about installing the Creo View MCAD and ECAD Adapters, see
the following documents on the Reference Documents page:
•

Creo View MCAD Adapters Installation and Configuration Guide

•

Creo View ECAD Adapters Installation, Configuration, and Publishing Guide
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Technical Support
Contact PTC Technical Support via the PTC website, phone, fax, or e-mail if you
encounter problems using your software. You can log a new case or track an
existing case or SPR (Software Performance Report) using the PTC webpage at
www.ptc.com/support/index.htm.
You must have a Service Contract Number (SCN) before you can receive
technical support. If you do not have a SCN, contact PTC License Management
using the instructions in the Customer Service Guide. This guide is on the PTC
webpage at www.ptc.com/support/index.htm.
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Documentation for PTC Products
PTC provides documentation for download at PTC.com. The following forms of
documentation are available:
•

Context-sensitive Help with a search facility and quick links to helpful
information.

•

Installing Creo 3.0: Creo View and other books as PDF files. To view and
print the books, you must have Adobe Acrobat Reader installed.

Press F1 or click

on a user interface item to get context-sensitive Help.

To access all PTC Documentation from PTC.com, you must have a valid user
account. Go to the Create New PTC eSupport Account page to request a user
account or call Customer Support. For worldwide phone numbers click Contact
under Customer Support Guide on the PTC webpage at www.ptc.com/support/
index.htm.

Feedback to Documentation
PTC welcomes your suggestions and comments on its documentation—send
feedback to the following address:
mcad-documentation@ptc.com
Please include the name of the application and its release with your comments.
For online books, provide the book title.
Additionally, you can report any documentation issues using the online Case
Logger tool. On the second Case Logger page, select a product and then select
Help Center / Documentation from the Technical Area list. Upon submission of all
information, a case number is returned immediately.

Documentation Conventions
PTC documentation uses the following conventions:
Convention
Bold

Courier
Courier with lessthan and greaterthan
symbols (< >)

Item
Menu paths, dialog box options,
buttons, and other selectable
elements from the user interface
User input, system messages,
directories, and file names
Variables for which an
appropriate value is substituted

Example
Click File ▶ New.
Click OK.
Processing
completed.
output=
<LOADPOINT>
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Note
Examples of command-line arguments may contain hidden line breaks to fit
on the page.
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This chapter describes the materials in your software shipment. It describes the
various editions of Creo View, and it outlines the prerequisites for installing and
running the software.
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What You Receive
PTC (Parametric Technology Corporation) sends the following materials related to
your software order:
•

Software Order Confirmation e–mail—Before the receipt of your PTC
software, you will receive an e-mail containing all the details of your order.

•

Software DVD—Your order contains one or more DVDs for each product
purchased. These programs are included on the Creo View DVD:
○ Creo View client
○ Creo View ECAD Validate
○ Watermark Editor

Editions of Creo View
Creo View comes in two licensed editions and one unlicensed edition, all based on
the same core viewing technology:
•

Creo View—Includes all core functionality for MCAD, ECAD, or both,
including interoperability with Windchill. Requires a FLEX license, and some
optional modules require additional licenses.

•

Creo View Lite—Provides limited viewing and markup functionality and
interoperability with Windchill. Requires a legal usage license that comes
bundled with the Windchill client.

•

Creo View Express—Provides basic viewing functionality without a license
and is not interoperable with Windchill.

The Creo View license is configured for MCAD, ECAD or both. If you purchase
Creo View MCAD, the functionality of the Lite edition of Creo View ECAD is
provided, and vice versa. Depending on the Creo View license configurations set
up by the system administrator, you can retrieve license options for your
workstation according to your tasks. The optional modules can be set to load at
startup or when required. This flexibility provides efficient license sharing. To
work offline, you must go online and borrow temporary Creo View licenses. The
following optional modules require additional licensing:
Creo View Edition
MCAD

ECAD
General License Options
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Module
Animator
Interference Analysis
Design Check
Compare
Massive Assembly
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Massive Assembly Requirements
The Massive Assembly option (FlexNet license feature 280) is required to open
large assemblies. The option is supported only with the Creo View MCAD Edition
and is not supported for use with Creo View Lite or Creo View Express Editions.
The option is required if addressed memory exceeds the following thresholds
while opening large data sets in Creo View:
Release
Creo View 1.0
Creo View 2.0
Creo View 3.0
Creo View 3.1

Creo View
2.0 Gb
3.5 Gb
8.0 Gb
8.0 Gb

Note
The following table indicates the memory limitations of Creo View Lite.
Release
Creo View 1.0
Creo View 2.0 or later

Creo View Lite
2.0 Gb
3.5 Gb

Before You Begin
Before you install Creo View or Creo View Lite, make sure that all the
prerequisites are met:
•

You have opened an online account at PTC.com (Administrators of Creo View
only).

•

You have received the Software Confirmation Order e-mail with the product
code or the Sales Order Number for your shipment. Alternatively, you must
have received your License Pack via e-mail from PTC License Management
(Administrators of Creo View only).

•

You have received the product DVD in your software shipment. If not, follow
the link on your Software Confirmation Order e-mail to download the
installation package to a folder on the local or the network computer.
Alternatively, download Creo View from PTC.com or from Windchill. See
Downloading Creo View or Performing an Installation from the Web.

•

You have read the READ THIS FIRST document for known issues.

•

You have checked the following locations for information on support of
various platforms, languages, and toolkits:

Overview
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○ The Creo View Clients & Toolkits Software Matrix. The matrix is available
on the Reference Documents site.
○ The System Prerequisites.
You must install PTC License Server Manager before installing Creo View except
in these cases:
•

You have purchased node-locked licenses.

•

You are a user of Creo View Lite or Creo View Express.

See Installing the PTC License Server.

Opening a PTC Online Account
You must have a PTC online account to generate a license and install Creo View.
Use the following instructions to create an online account:
1. On a computer connected to the Internet, go to the Create New PTC eSupport
Account page.
2. Fill in any empty boxes.
3. Click Create Account. A confirmation page indicates a successful account
creation.
4. Review and print this confirmation for your record. A confirmation of your
account is sent to your e-mail address.

Resetting Your Password
If at any time you do not remember your PTC.com password, follow these
instructions:
1. Open the Reset Your Password page.
2. Type your user name.
3. Click Continue. A URL to reset your password is sent to your e-mail address.

System Prerequisites
This section describes the prerequisites for hardware, operating systems, graphics
cards, and software.
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Hardware and Operating System Requirements
Because you can view files with widely varying size and complexity, the hardware
requirements partly depend on the type and size of files. The minimum
requirements are sufficient for small-sized or average-sized files. For optimum
performance, meet these recommended specifications:
Item
Random access memory
(RAM)
Central processing unit
(CPU) or Core

Minimum
Requirement
1 GB

Recommended
Specification
2 to 4 GB

Single-core, 1-GHz x86

Dual-core or greater, 2GHz x86

Intel compatible

32-bit or 64-bit
Disk space

Operating system

500 MB for a 32-bit
platform
800 MB for a 64-bit
platform
Windows XP 32-bit

Intel compatible
1 GB for the installation
Additional disk space for
data
Windows 7 64-bit

Solaris 10 x64

Solaris 10 x64

Redhat Linux 5.2 amd64

Redhat Linux 6.2 amd64

Novell SUSE 12.0 amd64 Novell SUSE 12.0 amd64
The Platform Support page contains information on requirements for hardware,
graphics drivers, and operating systems for PTC products, including Creo View:

Graphics Requirements
You must have OpenGL library version 1.1 or later installed on your machine.
Make sure you have the latest drivers for your graphics hardware. You can
download the latest drivers from the manufacturer’s website. The graphics
requirements depend on the size and complexity of your data sets. If you plan to
view and manipulate large or complex CAD files, check PTC’s list of supported
hardware for a list of appropriate graphics cards:
Platform Support
Applying special configurations to your graphics card is not recommended.

Overview
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Platform-specific Requirements
Creo View supports Windows, Linux x64, and Solaris x64. For Windows, you
must have administrative privileges to install Creo View. These are the
prerequisites for all Redhat Linux releases:
•

OpenMotif runtime libraries (“openmotif” package) must be installed on the
system using your operating system’s package manager. For example, yum.

•

You must have the latest proprietary graphics drivers from your graphics card
vendor. Your operating system’s graphics drivers are not sufficient.

For Redhat Linux 6.0 and later, you must also meet these prerequisites:
•

75–dpi fonts (“xorg-x11-fonts-75dpi” package and “xorg-x11-fonts-ISO88591-75dpi” package")

•

2.96-Redhat compatibility standard C++ libraries (“compat-libstdc++-296”
package, “libstdc++” package, and “libstdc++.i686” package)

For more details on platform support, see the READ THIS FIRST document.

Software Requirements and Helper Applications
For Windows installations, all of the software requirements are automatically met
when you install from one of these locations:
•

Product DVD

•

Windchill Software Downloads page

•

CreoView_64.exe or CreoView_32.exe executable files

If you install the application as an administrator directly from the MSI file, the
software prerequisites are not automatically met. See Deploying Creo View and
Customizing the Installation for more information.
Microsoft C++ Runtime and OpenGL 1.1 or later are required for installing and
running Creo View. C++ Runtime is shipped with Creo View and installed
automatically if needed. If you already have C++ Runtime, the installation is not
modified.
Other helper applications are shipped and automatically installed with Creo View:
•

Creo View Files Tools—Used for transforming or optimizing Creo View data.

•

Creo View ECAD Adapters—Required for natively viewing the supported
ECAD file formats. Creo View ECAD Adapters is installed automatically only
with the DVD installer. See Installers for Creo View for more information.

•

pview_batch.exe tool—Useful for scripting or troubleshooting.
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Browser Support Requirements
You may have to set special options for your Web browser. Details follow.
Cross-Locale Support for Online Help
For best results, access the Help in the same language you set for your operating
system. You may see corrupt characters if you view the Russian or Asian language
Help on a European language operating system, or if you view European language
Help on a Russian or Asian language operating system. In most cases, you can
circumvent the problem by setting the encoding in your browser:
•
•

Internet Explorer—Click View ▶ Encoding ▶ Auto-Select.
Mozilla Firefox—Install the CHM reader add-on and select Auto-Detect or
Auto-Select, depending on the language version of Firefox.

Google Chrome Support for Creo View MCAD and ECAD
The Google Chrome browser has these limitations with the Creo View clients:
•

The Version Checker plug-in does not work with the Chrome browser.

•

Before using Creo View with the Chrome browser, you must install Creo View
from one of two places:
○ On the Software Downloads page, accessible through the Windchill client
at Quick Links ▶ Software Downloads ▶ Setup and Installation: Creo View
Installation. See Performing an Installation from the Web for more
information.
○ From the DVD or from the downloaded DVD image (use the installer
script setup.vbs). For more information, see Performing an Installation
from the DVD.

PTC Customer Agreement
Before you install software, you must accept the PTC Customer Agreement: To do
so, follow these steps:
•

You must accept the license agreement to proceed even if a license agreement
already exists. The license agreement shown supersedes the previous license
agreement.

•

If you decline the license agreement you cannot proceed.

See Performing an Installation from the DVD, Performing an Installation from the
Web, or Performing an Installation Using the Executable File.

Overview
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Quick-Start Installation
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Performing a Quick-Start Installation...........................................................................24
Where Your Software Is Installed ................................................................................24

This chapter provides a quick-start approach for these users:
•

Experienced users who have previously installed license management and
product software on license server, license client, and node-locked machines.

•

Users of Creo View Lite or Creo View Express

For step-by-step installation instructions, read the subsequent chapters in this
guide. New users can refer to the chapter Installing Creo View.
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Updating PTC License Server
You must have PTC License server installed before you install Creo View. If you
are updating your software to a later release, you must update your PTC licenses.
See Updating the License Server for details. You need not install PTC License
server if you purchased uncounted node-locked licenses, or if you are installing
Creo View Lite or Creo View Express.

Performing a Quick-Start Installation
Install Creo View to a client machine and to the license server machine using the
following workflow:
1. Start the installer.
2. Accept the PTC Customer Agreement.
3. Accept the default installation path or set a new path.
4. Click Install. The Creo View clients are installed.
See Performing an Installation Using the Executable File or Installing Creo
View for UNIX for details on the installation process.
5. Click Finish.

Where Your Software Is Installed
The software is installed in a default directory. You can modify the path during
installation. The default path follows:
C:\Program Files\PTC\Creo <release_number>\View\
PTC License Server, Creo View, and any related components are installed by
default into separate subdirectories within the PTC directory. You cannot change
the installation location for Creo View ECAD Validate.
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This chapter explains how to obtain or update licenses. It also provides
instructions to install PTC License Server, a third-party license management
software for Creo View. You must install PTC License Server Manager before
installing Creo View, except in the following cases:
•

You have purchased uncounted node-locked licenses. Refer to your sales
documents for your license type.

•

You are a user of Creo View Lite or Creo View Express

The license server need not be installed on the same machine as Creo View. For
the version requirements appropriate for your license server, see the READ THIS
FIRST.
PTC uses FlexNet Publisher from Flexera Software, Inc. as its license server. See
License Management Software for an overview and benefits of the license
management software. The FlexNet Publisher License Administration Guide may
be helpful as you install PTC License Server.
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Using the License Server Manager
The license server manager handles the initial contact with your PTC software that
uses FlexNet licensing. It passes the connection to the appropriate vendor daemon.
A license server manager serves the following purposes:
•

Starts and maintains vendor daemons for serving license rights from different
software.

•

Transfers specific software requests to the correct vendor daemon.

There are two versions of the license server manager for license administration:
•

lmadmin—Uses a graphical user interface (GUI)

•

lmgrd—Uses a command-line interface

PTC currently ships with its products a license server manager based on
lmadmin with the ptc_d vendor daemon at version 11.10. It is a replacement to
the lmgrd−based license server manager shipped with the earlier releases of PTC
products. If you are using an lmgrd−based license server manager with ptc_d
vendor daemon of version 10.8.x.x, you need not migrate to lmadmin.

Verifying System Requirements
Installation requirements for the license server manager software, follow:
•

On all Microsoft Windows platforms, you must have administrative privileges
to install the PTC License Server.

•

You must have TCP/IP (Transmission Control Protocol/Internet Protocol)
installed and configured correctly on your Windows system before installing
the software.

•

For Windows Server 2008 R2, FlexNet Publisher 10.8.x.x, or later, is
supported. It is available for installation only as a downloadable utility.

•

To use the lmadmin−based license server manager on Windows platforms,
you must install the Microsoft Visual C++ 2005 SP1 Redistributable Package
(x86). You can install this package during the license server installation
process.

Before You Proceed
Gather all the necessary information that follows about the installation of the
license server manager:
•

Check the following documents for the latest installation settings:
○ The READ THIS FIRST document of your product for any changes to
your computer settings
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○ The FlexNet License Hardware Notes – PTC License Server for license
server installation requirements.
•

Make note of your product code that arrives via e-mail. If you have received a
license file via e-mail, store it at a secure location on your disk.

•

If you have already installed PTC License Server based on lmgrd and choose
to migrate to lmadmin, complete these steps before the migration:
1. Shut down any lmgrd service or processes running on the system.
2. Save the license.dat file from your existing license server installation
to a secure location.
3. Uninstall the previous installation completely.
See “Migrating from lmgrd to lmadmin” in the FlexNet Publisher License
Administration Guide for more information.

Obtaining a License
You must generate or update existing licenses to use the latest software for Creo
View. Licenses determine the edition and optional modules that you are
authorized to run on your computer. You can get a license for Creo View MCAD
or Creo View ECAD in two ways:
•

New customers—Use the PIM installer (PTC Install Manager). See the next
section.

•

Existing customers—Use existing tools (required). Skip to the section Existing
Customer Licensing.

Creo View uses a PTC License Server powered by FLEXnet Publisher 11.10.x or
later from Flexera Software Inc. If you are already running that license server for
another Creo application, you need only update your license file to support the
latest version of Creo View. If you are a new user, or if your license server is
outdated, you must install the PTC License Server when using floating licenses.
New Customer Licensing
The PTC Install Manager streamlines the license installation process for new
customers. Use the link on the Shipping Confirmation Letter. You need your Sales
Order Number (SON) and an upgraded PTC account associated with the customer
number. To begin, update your account with a user name and password at the
following link:
http://www.ptc.com/appserver/common/account/secure/premiumAccount.jsp
If you do not have a PTC Support account, you can open one here:
https://www.ptc.com/appserver/common/account/create.jsp

Obtaining and Configuring Licenses
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Perform the following steps to obtain the license using the PIM installer, which
also has on-screen instructions:
1. Start the PIM installer from the link on the Shipping Confirmation Letter.

Note
You must run the installer on the machine to be licensed. This is true for
both a floating license for a license server or a node-locked license for a
single client machine.
2. Type your user account name (usually your e-mail address), and then type
your SON (Sales Order Number). Your license file is downloaded. For floating
licenses, PTC License Server is also installed.
3. Click Next. The License Agreement appears.
4. Accept the agreement and click Next. A message appears.
5. Verify the network card for your license file configuration, and then click
Next. This step determines automatically the Host ID of the license. A
message appears.
6. Supply your license file. The installer downloads the licenses and installs the
License Server if applicable.
Node-locked licenses are saved locally in a path noted on the screen. A copy of
the license type will be e-mailed to the address on file for the account used in step
2.
Existing Customer Licensing
Existing customers should continue to use the existing licensing tools. Visit the
Customer Support Guide page at https://support.ptc.com/, click Licensing, and
then follow the instructions to manage your licenses.

Installing the PTC License Server
After you have received an e-mail from PTC with the product codes for your
software order, install the Standalone PTC License Server. Follow the installation
instructions in the Standalone PTC License Server guide on the Reference
Documents page.
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Borrowing and Returning Licenses
To work independently of a server, for instance from your laptop at home or at a
customer site, you must borrow a temporary license. License borrowing is
available only on Windows. After 14 days this license expires, but it is good
practice to borrow it only as long as needed so it is available for other users.
Borrow and return licenses using an executable file that comes with the software.
Run it using arguments to borrow licenses for the versions and options you need.
Instructions follow.
1. Open a command prompt on a computer with a server connection.
2. To read a short help message, type <Creo View installation
location>\bin\pvlicense_borrow.exe
3. Add arguments to the command line as follows:
•

To borrow a license, type -borrow and then the features and options to
borrow, and the license end date. See Example: Selecting Licenses to
Borrow.

•

To return a license, type -return and then the features or options to
return.

•

To view a list of currently borrowed licenses and their expiry dates, type
—list.

4. Press ENTER.
5. To verify that your borrowed license works, disconnect your computer from
the network and run Creo View.
The general structure of the command-line syntax for borrowing a license consists
of the following elements: pvlicense_borrow [-server
LicenseServerInfo] dd-mmm-yyyy[:hh:mm] LicenseFeature
[+LicenseOptions].
A typical license borrowing request looks like this: D:\Users\myname>"C:\
Program Files\PTC\Creo <release_number>\View\bin\
pvlicense_borrow.exe" -borrow 31-dec-2012 pvmcadpro
+largeaddress +interference +animation +designcheck.

Example: Selecting Licenses to Borrow
Features available for a Creo View license follow:
License Feature
Description
pvmcadpro
Creo View MCAD
pvecadpro
Creo View ECAD
pvstandard

Obtaining and Configuring Licenses

ProductView Standard

29

License Feature
pvbatchprint
pvbatchinterference

Description
Batch printing utility—Prints multiple
files with a server-controlled batch job.
Batch interference detection utility—
Performs multiple interference
detection queries with a servercontrolled batch job.

If you purchased Creo View MCAD, these options are available:
Creo View MCAD Options
+largeaddress

+interference
+animation
+designcheck

30

Description
Massive assembly—Opens very large
assemblies. For more information, see
Massive Assembly Requirements in the
Overview chapter.
Interference detection—Analyzes
structures for interferences
Animation—Creates animations
Design check—Provides tags for
collaboration and review
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Downloading Creo View
Downloading Creo View from PTC.com ......................................................................32

This chapter describes the steps for downloading the DVD image of Creo View
from PTC.com.
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Downloading Creo View from PTC.com
Follow the next procedure to download Creo View.
1. Visit the Order or Download Software Updates page:
http://www.ptc.com/appserver/cs/software_update/swupdate.jsp
You may have to type your user name and password and click Log In.
2. Click Order or Download Software Updates. The Authorized Use Only page
opens.
3. Under Customer Search, type your Customer Number or Customer Name and
click Next. The PTC Software Download page opens to Step 1: Select the
Product Family.
4. Select CREO VIEW & PRODUCTVIEW. The PTC Software Download page opens
to Step 2: Choose Release & Download.
5. Find the release to download and click to expand it.
6. Click next to Creo View Clients.
7. To download the most recent datecode of the release, click to expand Most
Recent Datecode, and then next to Download now, click HTTP. The download
begins.
8. To download another datecode, follow these steps:
a. Click to expand Show all Other Available Datecodes.
b. Click next to the datecode to download.
c. Next to Download now, click HTTP. The download begins.
You have now downloaded Creo View. See Performing an Installation from the
DVD for the next steps.
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Installing Creo View
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Performing an Installation from the DVD......................................................................34
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Performing an Installation Using the Executable File ....................................................36
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This chapter describes the process for installing Creo View using the installer on a
single machine. Administrators who want to deploy Creo View on multiple
machines should skip to the next chapter, Deploying Creo View and Customizing
the Installation.
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Downward Compatibility
Creo View is downward compatible. For example, you can retrieve Creo View
files (structures, viewables) created in a previous release of Creo View using the
current version of Creo View.

Installers for Creo View
There are three locations from which you can access a Creo View installer:
•

DVD or downloaded DVD image (Windows and UNIX).

•

Web installation from a Windchill server or the Creo View Toolkit page
(Windows only). See Downloading Creo View.

•

CreoView_32.exe or CreoView_64.exe downloaded executable files
(Windows only).

Instructions follow for using the various installers. See Installing Creo View for
UNIX for instructions on starting the downloaded installer in a UNIX
environment.

Performing an Installation from the DVD
Use the product DVD or downloaded DVD image to install Creo View, the Creo
View ECAD Adapters, and Creo View ECAD Validate. You install the group of
programs automatically using the workflow below. Follow the procedure again to
install the Watermark Editor tool separately.
1. Start the installer in one of these ways:
•

Load the DVD.

•

Extract the downloaded ZIP file into a new, empty directory, and then
double-click setup.vbs.

The Creo View -Clients dialog box opens.
2. Select a language and click OK. The Creo View — Clients installer dialog box
opens to the Before You Begin page.
3. Read the information, and then click Next. The PTC Customer Agreement page
opens.
4. Read the Terms and Conditions and select I accept.
5. Click Next. The Select Installation Type page opens.
6. Select the software to install:
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•

Install Creo View Clients

•

Install Watermark Editor

Creo® View 4.0 Installation Guide

Note
The Watermark Editor is available only on Windows.
7. Click Next. The Select Directory page opens.
8. Under Installation Directory, accept the default directory or browse to a new
path, and then click Select. The Review Settings page opens.
9. Review the settings and the disk availability, and then click Install. Creo View
is installed.
You have now installed Creo View. To start the application, continue to the next
chapter, Starting Creo View and Modifying an Installation.

Performing an Installation from the Web
The Windchill Help contains general instructions for downloading and installing
Creo View from the Windchill Software Downloads page. If Creo View is not
already installed on your machine, you can customize the installation. To
minimize the file size, select only the elements you need from the Creo View
Installation page. A summary of the number and size of the files to install updates
automatically. If you are updating your version of Creo View, you cannot modify
the installation directory. Instructions for the installation follow:
1. Under Options, select one or more of these features:
•

AutoCAD Viewers—Imports the AutoCAD file filter.

•

Import Filters—Imports the other supported external file filters.

•

Download Help Files—Provides information on functionality and

procedures for completing tasks.
2. Under Languages, select one or more languages for the user interface and the
Help.
3. In the box next to Installation Directory, accept the default path or type a new
path.
4. For first-time installations, click Install. For updates, click Reinstall. The
installation begins.
You can download CreoView_64.exe or CreoView_32.exe and perform
the installation manually using the link at the bottom of the Creo View Installation
webpage. See Performing an Installation Using the Executable File. You must
download and install the Creo View ECAD Adapters separately, using these links:
•

32-bit

•

64-bit

Installing Creo View
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You have now downloaded and installed Creo View. To start the program,
continue to the next chapter, Starting Creo View and Modifying an Installation.

Performing an Installation Using the
Executable File
If you download the installer, you can use the executable file to perform a simple
installation or an advanced installation. A simple installation automatically uses
the default installation location, C:\Program Files (x86)\PTC\Creo
<release_number>\View\. These features are also installed:
•

Demonstration Dataset

•

Import Filters—All

•

Language support—English only

To add languages or remove features, skip to the section below, Performing an
Advanced Installation.
Performing a Simple Installation
To install Creo View and the default components to the default location, follow
the steps below.
1. Double-click CreoView_32.exe or CreoView_64.exe. The PTC Creo
View 3.0 Setup dialog box opens to the PTC Customer Agreement page.
2. Read the Terms and Conditions, and then select I accept the terms in the
License Agreement.
3. Click Install. Creo View is installed.
4. Click Finish.
To install the Watermark Editor tool, see Installing the Watermark Editor Tool
Using the Executable File below.
Performing an Advanced Installation
To modify the location or contents of the installation, including language support,
follow the steps below. You can add or remove entire features, or selected
components of a feature. For example, you can remove all import filters, or you
can set each filter’s status individually.
1. Double-click CreoView_32.exe or CreoView_64.exe. The PTC Creo
View 3.0 Setup dialog box opens to the PTC Customer Agreement page.
2. Read the Terms and Conditions, and then select I accept the terms in the
License Agreement.
3. Click Advanced. The Destination Folder page opens.
4. Accept the default path for the installation, or set a new path:
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a. Click Change. The Change destination folder page opens.
b. Next to Look in, browse to a new location.
c. Click OK. The path is changed.
5. Click Next. The Product Features page opens.
6. To add or remove one or more features, such as language support or file
import filters, follow these steps:
a. Next to a feature to remove, click , and then select Entire feature will be
unavailable.
b. Next to a feature to add, click , and then select one of these options:
•

Will be installed on local hard drive—Installs the selected feature or

component.
•

Entire feature will be installed on local hard drive—Installs all

components of the selected feature.
7. Click Install. Creo View is installed.
8. Click Finish.
You have now installed Creo View. To start the program, continue to the next
chapter, Starting Creo View and Modifying an Installation.
Installing the Watermark Editor Using the Executable File
Creo View is shipped with a Watermark Editor tool. You must install it separately.
The recommended method for installing the tool is the DVD installer. If you
prefer, start the subinstaller from a subdirectory of the installation folder.
Installation instructions follow.
1. In the DVD directory, navigate to and open \installers\wmeditor.
2. Double-click ProductView_Watermark_Editor.msi. The
ProductView Watermark Editor Setup Wizard dialog box opens.
3. Click Next. The End-User License Agreement page opens.
4. Read the agreement, and then select I accept the terms in the License
Agreement.
5. Click Next. The Destination Folder page opens.
6. To accept the default installation location, click Next, and then skip to step 8.
7. To set a new installation location, follow these steps:
a. Click Change. The Change destination folder page opens in a new window.
b. Browse to a new location, and then click OK. The installation location is
updated.
c. Click Next.
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8. Click Install. The Watermark Editor tool is installed.
9. Click Finish.

Installing Creo View for UNIX
Install Creo View on a Solaris x64 or Linux x64 machine using the workflow
below. To perform an extra step required for using Creo View with Windchill on
UNIX, see Embedding Creo View in a Web Browser below.
Performing a UNIX Installation
When you download the DVD image from PTC.com, you receive a ZIP file.
Instructions for starting the installation follow.
1. Extract the ZIP file into an empty directory, <installer_path>.

Note
To keep file permissions stored in the ZIP file, you must extract the
archive from a UNIX machine.
2. From <installer_path>, run ./setup. The Creo View -Clients dialog
box opens.
3. To continue with the installation, follow the instructions in Performing an
Installation from the DVD.
Embedding Creo View in a Web Browser
To use Creo View with Windchill on UNIX, you must manually add an
environment configuration to embed Creo View in your web browser. Instructions
for finding the Readme file follow.
1. Browse to <Creo_View_installation_path>\browser_plugins.
2. Follow the instructions in readme.txt.

Enabling the Launching of Creo View
from Windchill Using SSL Client
Certificates
Out-of-the-box, Creo View is not configured to use SSL Client Certificates, a
requirement for it to correctly authenticate HTTP requests sent to a Windchill 11.0
server configured for the Public Key Infrastructure (PKI ) Authentication method.
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As a result, when launching Creo View from Windchill, using the Open in Creo
View action or by clicking on the Thumbnail, the following error message may
appear.
Windchill request error
ATTENTION: Error occurred communicating with Windchill.
Contact your Windchill administrator for help.

This occurs if Windchill is configured to use Public Key Infrastructure (PKI )
Authentication.
To resolve this issue and enable the use of SSL Client Certificates when launching
Creo View from Windchill, set the following environment variable to any value,
for instance PVIEW_SEARCH_ALL_CERTIFICATES=<1>, in the runtime
environment of Creo View on all client machines.

Installing Creo View
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6
Starting Creo View and Modifying
an Installation
Starting Creo View ....................................................................................................42
Modifying an Installation ............................................................................................43
Uninstalling Creo View ..............................................................................................43

This chapter explains how to start Creo View and configure the startup. Proceed to
the end of the chapter for the procedure to uninstall Creo View.
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Starting Creo View
After your license management and product software have been installed, start
Creo View. You can run the application using the Start menu. Click Programs ▶
PTC Creo ▶ PTC Creo View <release_number>. The first time you start the
software, the PTC Creo View Startup dialog box opens. Instructions follow for
setting the edition and license options. To set a language for the Creo View user
interface, see Setting the Language below.
Setting the Edition and License Options
Use the Creo View Startup dialog box to set the options for starting Creo View as
follows:
1. To make the startup options the default, clear the Choose edition at startup
check box.
2. Next to Choose Creo View Edition, select the edition to start:
•

Creo View Lite

•

Creo View MCAD

•

Creo View ECAD

•

Creo View MCAD and ECAD

•

Creo View Standard

3. For each license option that you purchased, select a loading option:
•

Load at startup

•

Load when required

•

Never (optional modules only)

4. To update your license, under License Information in the License Server box,
type the name of the server or the path to the node-locked license file.
5. Click Apply. Click OK. Creo View starts.
Setting the Language
By default, the language of the Creo View user interface is determined according
to your operating system’s settings. To set a different language for Creo View
from the operating system language, use the environment variables described
below.
The generic environment variable, LANG, sets one language for all programs on
your machine. You can use PTC-specific variables to designate another language
for one or more programs:
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•

PVIEW_LANG—Creo View

•

PRO_LANG—Creo Parametric and its associated applications. When you set
this variable, you must also set PVIEW_LANG. This is true even if you want
the same value for PRO_LANG and PVIEW_LANG.

Modifying an Installation
If you installed Creo View from the DVD, all languages and features are already
installed. If you installed the software from the downloaded CreoView_
32.exe or CreoView_64.exe installers, it is good practice to use the installer
to modify your installation as follows:
1. Start the installer. The Creo View 3.0 Setup dialog box opens to the welcome
page.
2. Click Next. The Change, repair, or remove installation page opens.
3. Click Change. The Product Features page opens.
4. Add or remove features. See Performing an Advanced Installation for more
information.
5. Click Change. The installation is changed.

Uninstalling Creo View
You can remove an installation of Creo View through the Control Panel as
follows:
1. From the Start menu, click Settings ▶ Control Panel.
2. Double-click an icon according to your version of Windows:
•

Programs and Features—Windows 7

•

Add/Remove Programs—Earlier versions

3. In the program application list, select the application to remove.
4. Right-click and choose Uninstall from the shortcut menu. A confirmation
appears.
5. Click Yes to proceed. Creo View is removed.

Note
You must separately remove the helper applications using the previous
procedure.

Starting Creo View and Modifying an Installation
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Deploying Creo View and
Customizing the Installation
Deploying Creo View Using a Silent Installation ...........................................................46
Deploying Creo View from a Downloaded Executable File ............................................48
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Performing a Silent Uninstallation ...............................................................................52

This chapter is for system administrators and applies to Windows only. It provides
information on deployment, including example procedures for customizing the
automated installation of the program.
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Deploying Creo View Using a Silent
Installation
Perform a silent installation in either of these ways:
•

Deploy the program from the downloaded CreoView_32.exe or
CreoView_64.exe—See Deploying Creo View from a Downloaded
Executable File for an example.

•

Extract the executable file and directly call msiexec.exe on some or all of
the required installers—See Customizing the Installer for examples.

In the command shell, you can enter msiexec /? to read an explanation of all
the generic MSI options. Some common examples of options for a silent
installation follow:
•

/qn—Installs the software with no installer user interface.

•

/qb—Provides a progress bar with a Cancel button.

•

/qb!—Provides only a progress bar. A user cannot stop the installation.

Generic Features for Creo View
Option Name
main
en
pvocxusr

pvocxsys
plugin_acrobat
doc
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Feature
Core Creo View runtime. This feature
is required.
Basic language resources. This feature
is required.
User-only ActiveX component that
goes into the Program Files
directory.
Note
You need to enable the Adobe PDF
Reader ActiveX Control Add-on
from the Windchill Server to view
Creo View viewables in standalone
or regular mode.
System-wide ActiveX component. This
is required for standard users.
Adobe Acrobat add-in program for
marking up PDF files.
CHM Help file. This feature is
required.
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Generic Features for Creo View (continued)
Option Name
licvar

Feature
Sets the license server variable. Must
be used with the LICENSESERVER
property.
Sample data set.

demo
File Import Filters

Filter
2D DWG and DXF support. This
feature is a prerequisite for pvifdwf.
2D and 3D DWF and DWFx

Option Name
dwg
pvifdwf

Basic set of files required for installing
the filters listed below.
IGES
STL
GBF
VRML
DGN
STEP
PGL

pvimport
pvifiges
pvifstl
pvifgbf
pvifvrml
pvifdgn
pvifstep
pvifpgl
Language Features
Language
English—This feature is
required.
German
Spanish
French
Italian
Japanese
Korean
Russian
Portuguese—Brazil
Chinese—Simplified
Chinese—Traditional

Option for User
Interface
en

Option for Help

de
es

docde
doces
docfr
docit
docja
docko
docru
docpb
doccs
docct

fr
it
ja
ko
ru
pb
cs
ct
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Deploying Creo View from a Downloaded
Executable File
To call a silent installation directly from CreoView_64.exe, add the /v
argument to the program call immediately followed by all the parameters for the
underlying MSI package. An example follows:
start /w CreoView_64.exe /vADDLOCAL="ALL"
LICENSESERVER=”7788@licsrv.example.com” /qn

In the example above, the command is prefixed with start /w to force one
process to finish before another one is started. This is useful for scripting
installations. The feature licvar is included in the metafeature “ALL”.
Therefore, the property LICENSESERVER is sufficient.

Customizing the Installer
CreoView_32.exe and CreoView_64.exe are self-extracting archives that
each run CreoSetup.exe. CreoSetup.exe is a wrapper application for
chaining the installations of several installers in the archive, including
CreoView_32.msi or CreoView_64.msi. Running the MSI file alone does
not constitute a complete installation of Creo View. However, you can customize
the installer in these ways:
•

Remove applications installed by default

•

Bundle other applications with the Creo View installation

Use 7-Zip to extract the archive to a folder, and then modify its contents. Continue
to Creating and Deploying a Customized Installer for an example.

Creating and Deploying a Customized
Installer
You can add and remove applications from the Creo View installation. For
instance, the users in your organization have the following needs:
Required
Using Creo View client
Working with JT (*.jt) files

Not Required
Microsoft Visual Studio C++ 2010
Runtime Redistributable
Viewing ECAD designs

In this case, you may want to customize the installer in these ways:
•

Bundle the JT Import Filter with the Creo View installation

•

Remove Microsoft Visual Studio C++ 2010 Runtime Redistributable because
you have already deployed it. We will still deploy 2012 Runtime.
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Accomplish the customization by performing two basic tasks:
1. Prepare the directory structure by adding and removing installer files.
2. Modify CreoSetup.ini to run the installers correctly.
After you complete these tasks, you can deploy the software. The procedures in
the next sections contain instructions for completing the tasks above, and for and
the deployment.
Preparing the Directory Structure
Follow the steps below to customize the installation directory.
1. Create an empty directory (<directory>).
2. Copy CreoView_64.exe into <directory>, and then right-click the file
and choose 7–Zip ▶ Extract Here. The setup files are extracted from the
wrapper.
3. Delete CreoView_64.exe. These subdirectories and files remain:
•

\prereqs subdirectory

•

\pview subdirectory

•

CreoSetup.exe

•

CreoSetup.ini

4. Create a new subdirectory called \jtimport.
5. Navigate to the installation subdirectory on the JT DVD image:
cdimages/jtadapter/installers/

Copy CreoView_JT_Import_32.msi and CreoView_JT_Import_
64.msi, and then paste them into the \jtimport subdirectory you created
in step 4.
6. Under the \prereqs subdirectory, remove the two Microsoft Visual Studio
2010 C++ Redistributable x86 and Microsoft Visual Studio 2010 C++
Redistributable x64. They are called vcredist_x86_VS2010.exe and
vcredist_x64_VS2010.exe.
The directory is now ready. Continue to the next section to customize the INI file.
Modifying CreoSetup.ini
You have added an installer file to bundle the JT Import Filter with the Creo View
installation. You must now modify CreoSetup.ini to make these changes to
the default installation directives. You can delete unnecessary lines and sections
from the file, or you can modify them. In this example, they are modified.
•

Add new directives to run the JT installer

•

Remove or disable the vcredist_x##_VS2010.exe directives.

Deploying Creo View and Customizing the Installation
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Follow the next steps to update the INI file accordingly.
1. Open CreoSetup.ini in a text editor.
2. In the [Other Applications] section, find the line VC2010_X86=YES
and replace it with VC2010_X86=NO, or VC2010_X64=YES and replace it
with VC2010_X64=NO.
3. At the end of the [Other Applications] section, find these lines:
ECADADAPTERS_X86=YES
ECADADAPTERS_X64=YES

Modify them to call the JT installer instead of the Creo View ECAD Adapters
installer:
JTIMPORT_X86=YES
JTIMPORT_X64=YES

4. At the end of the file, find the sections for the Creo View ECAD Adapters,
such as the example below:
[ECADADAPTERS_X86]
PROGRAM=CreoView_ECAD_Adapters_32.exe
COMMANDLINE=/f /vADDLOCAL="ALL" REBOOT="ReallySuppress" /l*v
TempFolder]pvinstecadadapters.log" /qb!
LOCATION=..\ecad_adapters
; PRODUCTCODE=
PLATFORM=X86

Change the heading and information in the [ECADADAPTERS_X86] and
[ECADADAPTERS_X64] sections to information for the JT Import Filter, as
shown in these examples:
[JTIMPORT_X86]
PROGRAM=CreoView_JT_Import_Filter_32.msi
COMMANDLINE=ADDLOCAL="ALL" REBOOT="ReallySuppress" /l*v
"[TempFolder]pvinstjt.log" /qb!
LOCATION=jtimport
PRODUCTCODE={7D39690A-FB6B-4559-B1FD-26F7735162B3}
PLATFORM=X86
[JTIMPORT_X64]
PROGRAM=CreoView_JT_Import_Filter_64.msi
COMMANDLINE=ADDLOCAL="ALL" REBOOT="ReallySuppress" /l*v
"[TempFolder]pvinstjt.log" /qb!
LOCATION=jtimport
PRODUCTCODE={E6438BA9-7C4D-4D54-A87D-65272F3169A6}
PLATFORM=X64

5. Save CreoSetup.ini and close the text editor.
You have now defined the installation in the INI file:
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•

For more information on locating the code for an application, continue to the
next section, Finding the Product Code.

•

For more information on the INI file, skip to the section Understanding the
CreoSetup.ini File.

•

To begin deployment, skip to the section Deploying with the Customized
Installer below.

Finding the Product Code
This example uses the JT ProductCode for Creo 2.0 M020. Each release has a
unique ProductCode. An application also has a permanent UpgradeCode.
The UpgradeCode is not used by CreoSetup.exe because it does not
identify the version of the application. You can find the product code for the
applications to install by using the Registry Editor. On a computer where the
application is already installed, navigate to the registry key.

Caution
Do not modify the registry. Doing so can severely damage your computer.
1. Open a command prompt, and then type regedit.
2. Press ENTER. The Registry Editor opens.
3. On the left, navigate to this key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall

4. Find the application to install, and copy the key, including the curly brackets.
These are examples of the registry keys for Creo View 2.0 M020 JT Import
Filters:
•

32–bit—{7D39690A-FB6B-4559-B1FD-26F7735162B3}

•

64–bit—{E6438BA9-7C4D-4D54-A87D-65272F3169A6}

Understanding the CreoSetup.ini File
Each application in the file’s [Other Applications] section has a YES or
NO value. A YES value does not necessarily mean the application’s installer will
always be executed. Instead, each application with a YES value is a potential
installation. If your system has an installation that matches the product code line,
then nothing is done. If your system does not have a matching installation, the
application is installed.
The PRODUCTCODE line for each application is optional. In all cases, the
application is installed automatically when your system does not have the same
version installed. Providing a product code minimizes the time the installation
takes to complete.

Deploying Creo View and Customizing the Installation
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The value for the PROGRAM line must be a *.exe file or a *.msi file.
Deploying Creo View with the Customized Installer
You have now prepared the directory and modified the INI file. In this example,
deploy the applications with a passive installation. You may use one or both of
these strategies:
•

Run CreoSetup.exe directly from the network location.

•

Create a new, self-extracting archive from the modified directory. Make sure
the self-extractor calls CreoSetup.exe to chain all the installations to
deploy.

The call to CreoSetup.exe must include, in the command line, all MSI
arguments for the base Creo View installer. At this time, you cannot embed the
Creo View MSI arguments directly in CreoSetup.ini.
To perform the passive installation, open a command shell and enter the following
command:
CreoSetup.exe /vADDLOCAL="ALL" APPLICATIONFOLDER="C:\
ptc\Creo View" LICENSESERVER=”7788@licsrv.example.com”
/qb!

Note
Make sure there is no space between /v and the next character in the
command.
Creo View and the JT Import Filter are installed with a progress bar, but no Cancel
button. For more information on common examples of options for a silent
installation, see Deploying Creo View Using a Silent Installation.

Performing a Silent Uninstallation
MSI installers automatically uninstall a matching product as part of an upgrade.
Therefore, for upgrades it is unnecessary to perform a silent uninstallation.
However, if you do want to manually and silently uninstall one or more of the
Creo View applications, you must first obtain the ProductCode for each version of
the application to uninstall. New ProductCodes are generated for each release and
patch build of Creo View. This section contains instructions for finding the
ProductCodes and for using them to perform the silent uninstallation.
Obtaining ProductCodes
To query the MSI inventory and retrieve the ProductCodes, you can use any of
these methods:
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•

Visual Basic script

•

Powershell script

•

Free tool such as msiinv.exe

For example, execute the msiinv.exe with these arguments:
msiinv.exe -p > %TEMP%\msiinv_output.txt

You now have a list of all MSI packages and their ProductCodes in your %TEMP%
directory, in the file msiinv_output.txt. You can uninstall the applications.
Continue below.
Uninstalling the Applications
Use the msiexec.exe tool to uninstall one or more Creo View applications. For
each application to uninstall, you must run msiexec.exe with the
corresponding ProductCode. Instructions follow.
1. Note the ProductCode you retrieved in the previous procedure.
2. Open a command window, and type the following command:
msiexec.exe /x {<ProductCode>}

3. Press ENTER. The command is executed.
You have now manually and silently uninstalled the application. Repeat the
procedure above for each application to uninstall.

Deploying Creo View and Customizing the Installation
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Updating an Installation
Updating the License Server ......................................................................................56

This chapter explains how to update your copy of Creo View. Each time you
update your software to a new release, you must update your license file. New
license codes are not required if you are updating to a maintenance release of Creo
View within the same release. In some cases you may have to update the current
installation of PTC License Server. See the next sections for details.
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Updating the License Server
You can update the current installation of PTC License Server with your new
license information when updating your PTC software. An installation update of
PTC License Server is typically required in one of these scenarios:
•

Adding license information from your new Sales Order

•

Updating the existing license features in your license file with those of a
maintenance release

You may have to update the license server software itself depending on the
version installed. In such cases, you must uninstall PTC License Server using
administrative privileges and then follow the installation instructions in the
Standalone PTC License Server guide on the Reference Documents page.
Update your licenses using this workflow:
1. Make note of the product code that you have received via e-mail.
Alternatively, use the PTC License Management Web tools to request for a
license file via e-mail. Save the license file in an ASCII format to a secure
location on your disk.
2. Navigate to the \bin subfolder of your license server installation. The default
path follows:
C:\Program Files\FLEXnet Admin License Server\bin
3. Right-click ptcsetup.bat and choose Run as Administrator from the
shortcut menu. The PTC Setup — PTC License Server dialog box opens.
4. Click . The Open dialog box opens.
5. Browse to your license file, and then click Open. The path appears under
License File.
6. Click Configure. The Installation Progress page opens with a progress bar.
7. A warning opens. Click OK.
8. To check the status of your updated license, follow these steps:
a. Click Program Files ▶ PTC ▶ PTC FLEXnet Admin License Server. The
FLEXnet License Administrator webpage opens.
b. Near the top of the page, click Administration. The Administration tab
opens.
c. On the left, click Vendor Daemon Configuration. The Vendor Daemon
Configuration tab opens with your license.
d. Under the Status column, verify that the status is RUNNING.
PTC License Server restarts. For Triad configurations, two of the three partner
machines must be running before licenses can be distributed.
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Updating Creo View
After you install a particular release of Creo View, you can install a new
maintenance release. The previous release is overwritten.

Updating an Installation
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9
Hierarchical Visual Navigation
You can rapidly load the approximate 3D model graphics for very large Creo
View structures by loading 3D thumbnail image (PVT) files of the structures that
were previously created. Once the thumbnail is loaded you can switch to the full
3D model view (OL file). You can also revert from the full 3D model view back to
the 3D thumbnail image.
This functionality is available only under the following conditions:
•

•

3D thumbnail images have been generated for sub-level assemblies. This
requires configuration of the CAD worker or the server-side Thumbnail
Generator to create them. See Enabling Hierarchical Visual Navigation in the
Creo View MCAD Adapters 3.0 Installation and Configuration Guide.
Creo View options are configured to download and view thumbnails. See
About Thumbnails in the Creo View 3.0 Help .

Note
For more information read the Technical Support Knowledge Base Article
CS25318, which covers the complete configuration across all products.
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This appendix discusses license management software and describes the benefits
of PTC License Server. License simplification is explained for new and existing
users.
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Overview of PTC Licensing
PTC software including PTC optional applications must be licensed for use.
Licensing authorizes the installed software to run. Creo View licenses are not
time-sensitive.

License Types
Depending on the PTC product, a license can be one of the following types.
•

Node-locked licenses—Restricts the use of the software to a particular
machine (independent workstation).

•

Floating licenses—Served by the license server and can be used on any
machine connected over the network. There are two different types of floating
licenses:
○ Single server licenses—Configured for a single machine as the server.
○ Triad licenses—Configured for a set of three machines on the same
network that work together to manage a pool of floating licenses. This
configuration provides redundant backup in case of a server outage. An
identical license file is used for each Triad partner.

•

Extended license—An extended license makes floating licenses available for
locked modules.

•

Borrowed license—A borrowed license allows you to work temporarily on
your machine without being connected to the license server. Refer to
Borrowing and Returning Licenses for details.

For more information on the additional license types that are supported for your
product, refer to the product documentation.

PTC License Server
Flexera Software, Inc.’s FlexNet Publisher license management software is
integrated with PTC software. For more information, visit www.flexerasoftware.
com.

Benefits of Using FlexNet Publisher
Using FlexNet Publisher to control usage of licenses offers the following key
advantages:
•

Single-Server Solution—FlexNet Publisher can manage PTC software and
other vendor applications without conflict. Note that the PTC license file
cannot be combined with the license files of other vendors.

•

Immediate License Recovery—If there is a premature exit of the licensed
software (for example, the system shuts down), the FlexNet Publisher license
server automatically reclaims the PTC license.
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•

Increased Flexibility—System administrators can reserve or deny licenses
based on user name, host name, display name, or IP address. For more
information see Managing the Options File in the FlexNet Publisher License
Administration Guide.

•

Centralized License Storage—PTC customers can store all PTC licenses for
all PTC products in a single file for each license server.

•

Multiple Licenses for a Single Command—One command can be used to
execute multiple licenses of PTC software based on availability.

•

License Borrowing—Using FlexNet Publisher 8.6 or later, you can borrow
licenses from a license server and run a licensed application on a remote client
without being connected to the license server.

Downward License Compatibility Using
FlexNet Publisher
FlexNet Publisher license servers have downward compatibility with PTC
applications using FLEXlm license servers. For example, a Creo View 2.0 license
can run ProductView 9.1 software, because both releases of the software use the
same PTC License Server.

Note
To run the current release of Creo View, you must install FlexNet Publisher
version 10.8.x or later.

Running FlexNet Publisher with Other
Applications
You can use FlexNet Publisher to run PTC products as well as other applications.
Each application that uses FLEXlm or FlexNet Publisher has a corresponding
license server manager (lmgrd or lmadmin) and a vendor daemon. The license
server manager starts the vendor daemon (for example, ptc_d) that controls the
usage of licenses.
You cannot combine a PTC license file with a license file of another vendor. Do
not, for example, combine PTC feature lines with those of other vendors in a
single license file. This action causes the licenses to be invalid.
If all applications and vendor daemons are FLEXlm 6.1 or later, lmgrd or
lmadmin can process multiple license files. This is true even when the Host IDs
are different (as long as the license files refer to the same node). For more
information, see Managing Licenses from Multiple Software Publishers in the
FlexNet Publisher License Administration Guide.
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Understanding Timeout Parameters
Timeout parameters enable the license client and the license server to
communicate with one another so that licenses are released and available upon
request.
You can reconfigure the TIMEOUTALL parameter within a specified range, as
described in the next section, Changing the Inactivity Timeout Parameter.
Timeout
Parameter
Inactivity timeout
(TIMEOUTALL)

Value
120 minutes
(default)

Description
This parameter prevents a license from
remaining idle. If the license client is
inactive for a specific period, the license
can be reclaimed by the license server and
used by another license client. For the
Creo applications, the inactivity timeout
default is 120 minutes.
Activity is measured as active menu
selections.

License refresh
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1 minute

You can change the default of 120 minutes
so that the parameter ranges from 20
minutes (minimum value) to infinity
(maximum value).
A license refresh occurs at intervals of 1
minute. When you select a command after
such an interval, the license client
communicates with the license server. The
license client and the license server both
must be working. If the license server is
not found, the license client loses its
license to run. If the license client is not
found, the server reclaims the license for
use by another license client.
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Timeout
Parameter
Validation retries

Value
None

Description
The first time a license client cannot
validate its license the application's
graphical user interface will freeze. You
are immediately given the following three
options:
Click Retry to request a license from an
active license server.
Click Save File(s).

Startup

10 seconds

Click Exit to close the application without
saving the file or files.
Upon starting a session, the license client
requests a license and has 10 seconds in
which to have the request validated.

Changing the Inactivity Timeout Parameter
You can set the TIMEOUTALL parameter that determines how long the system
allows a license to remain idle before it is reclaimed by the license server. To
change the default inactivity timeout parameter, you must update the FlexNet
Publisher option file, ptc.opt in <ptc License Server loadpoint>/
FLEXnet Publisher/licensing. The default is 120 minutes. Edit the
default parameter:
TIMEOUTALL 7200
Change 7200 seconds (120 minutes) to another value in seconds.
The minimum value is 20 minutes (or 1200 seconds) and the maximum value is
infinity. To make infinity the default, remove the TIMEOUTALL parameter from
the ptc.opt file. If you set a minimum value to less than 20 minutes, the system
defaults to 20 minutes.

License Management Software
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This appendix contains basic information on lmadmin, a Web-based license
server manager. It also provides information on migrating from lmgrd to
lmadmin.
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Overview of lmadmin as a GUI-Client
The lmadmin license server manager supports a Graphical User Interface (GUI)
client with connection over HTTP. It provides a Web-based administrative
interface. It is compatible with license files and vendor daemons created with
FlexNet Publisher 9.2 and later. Use lmadmin for the following functions:
•

Perform server configurations and administration functions

•

Start the license server manager without any configuration options

•

Directly configure vendor daemon and the license server manager without
editing the license files

•

Import existing license files

•

Support multiple vendor daemons with a single lmadmin process

•

Display license rights status

•

Display alerts and monitor status of various processes, such as license
expiration or unavailable licenses

See the chapter lmadmin − GUI−based License Server Manager in the FlexNet
Publisher License Administration Guide for more information.

Differences between lmgrd and lmadmin
The lmadmin license server manager includes all the features of the lmgrd
license server manager. The differences between the two license server managers
follow:
lmgrd
lmadmin
Uses a command-line
Supports a GUI client with connection over
interface.
HTTP.
Configuration settings are
Configuration settings are session-based.
retained for all the sessions.
See the chapter Migrating from lmgrd to lmadmin in the FlexNet Publisher
License Administration Guide for more information.

Installing PTC License Server Based on
lmadmin
Follow the instructions given in the section Installing the PTC License Server to
install PTC License Server based on lmadmin. After you install the license server,
you can configure the license server administration settings using the FLEXnet
License Administrator Web interface.
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Working with the FLEXnet License
Administrator Web Interface
The lmadmin-based license server uses the FLEXnet License Administrator Web
interface. This interface replaces the lmtools utility used by the lmgrd-based
license server. You can launch the interface by clicking Yes at the end of the PTC
License Server installation. Alternatively, from the Windows Start menu click
Program Files ▶ PTC ▶ PTC FLEXnet Admin License Server ▶ PTC FLEXnet Admin
License Server Web Interface to open the interface. Using the FLEXnet License

Administrator, you can check the server status, start and stop the server, or
reconfigure the server.
The FLEXnet License Administrator Web interface has two main pages: the
Dashboard and the Administration pages. Click the Help button for information on

the FLEXnet License Administrator interface elements.
•

Dashboard—Displays any alerts and the current activity of the license server

manager.
•

Administration—Provides configuration tools for the license server

management system. The default username/password combination is admin/
admin for this password-protected page. You are prompted to change these
credentials the first time you log in. Only the overview information for the
Server Configuration and the Vendor Deamon Configuration tabs on the
Administration page is included in this document. Click a tab to open the
corresponding pages.

Controlling the License Server Manager Settings
A server administrator can use the options on the Server Configuration page to
control the settings for the License Server Manager.

Reconfiguring the Vendor Daemon
A server administrator can use the Vendor Daemon Configuration tab to verify
whether the server is running and to reconfigure the vendor daemon.
If PTC License Server has been successfully installed, Running appears under
the Status column.

lmadmin License Server Manager
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This appendix documents common problems that occur when you install Creo
View and PTC License Server. This appendix also provides general debugging
techniques and cites other sources of information available from the PTC website.
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Troubleshooting List
Skim through the following list of problems to find any that appear to be the same
as the one you are experiencing. The information is presented in the following
format.
Symptom: Describes the problem.
Cause: Lists the cause of the problem.
Solution: Provides steps to resolve the problem.

Cannot Connect to the License Server
Symptom: When you start Creo View, you receive an error message in the Startup
dialog box.
Cause: The license server is not running or the license client cannot reach the
server.
Solution: Verify that the license server manager and ptc_d daemons are running.
A network problem exists if a license client attempts to ping the server by host
name and the ping fails.

Invalid Licenses
Symptom: You receive the error message Invalid license.
Cause: Licensing information is inaccurate.
Solution: Return to the FLEXnet license editor and verify that the information
entered is exactly as it appears in your License Pack. If no licenses are listed,
return to the FLEXnet license editor and ensure no text is highlighted.
If all licenses are listed as invalid, verify that the PTC Host_ID in the
License Pack corresponds with what you see in the FLEXnet license editor. For
example, one server line and one daemon line represent a single server. Three
server lines and one daemon line represent a fault-tolerant or Triad configuration.
Remove all the lines that do not pertain to the PTC HOST_ID.
Your incremental lines must have no blank lines. Verify that all continuation
characters (\) are at the end of each line, except for the last line. If some licenses
are valid while others are invalid, find the invalid feature name lines in the
License File window and correct the text.
If you received your license codes via e-mail, remove any extraneous text such as
the header and footer. Another option is to delete the invalid license in the
FLEXnet license editor window.
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FlexNet Publisher Fails to Start (Triad
Configurations)
Symptom: PTC License Server does not start after a Triad server is installed and
configured.
Cause: The following requirement has not been met: two of the three partners of
the Triad configuration must be running (Quorum) before licenses can be
distributed.
Solution: Go to a shell window or a command prompt and change into the
<FLEXnet_Installation_Directory>\bin. Type in ptcstartserver.

General Debugging Hints
The ptc.log file records license server activities and can be found in
“\FLEXnet Admin License Server\logs\”. This file has useful
information that you should check when you have a problem.

Setting Variables and Installing Tools for
Troubleshooting
The Creo View installation includes software for troubleshooting. Install the
software and set troubleshooting environment variables as follows.
Installing Creo View Debug Symbols
Creo View Debug Symbols is a bundle of files for troubleshooting all Creo View
and Creo Illustrate programs. If Creo View crashes, the detailed information is
gathered by the configured trace file instead of by the Windows default
mechanism. Instructions for installing Debug Symbols follow.
1. Navigate to <installer_directory>\installers\debug_
symbols.
2. Double-click the installer for your platform:
•

CreoView_Client_Debug_Symbols_32.exe

•

CreoView_Client_Debug_Symbols_64.exe

The Creo View Debug Symbols Setup dialog box opens to the PTC Customer
Agreement page.
3. Read the Terms and Conditions, and then select I accept the terms in the
License Agreement.
4. Click Install. Debug Symbols is installed.
5. To read additional instructions required to start using Debug Symbols, select
View the Creo View Debug Symbols usage instructions.
6. Click Finish.

Troubleshooting Tips for Licensing and Creo View Runtime
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You must set the corresponding environment variable to activate Debug Symbols.
See the next section, Using Variables in Troubleshooting.
Using Variables in Troubleshooting
To aid in troubleshooting the runtime of Creo View, use these environment
variables:
•

PVIEW_PROC_TRACE=<full or relative file path>\
pvtrace.log—Generates a unique log file for each Creo View process
running. The log file saved to the path you set is called pvtrace_
<process number>.log.

•

PVIEW_CATCH_EXCEPTIONS=1—Works with Debug Symbols to gather
troubleshooting information. The information is stored in the trace file defined
immediately above. When you install Debug Symbols, you must set this
variable.

Online Information
See www.ptc.com/support/index.htm for a wealth of how-to information for new
and experienced users, including order and license support. The Customer Support
Guide provides online tools and other support services. You can search the
Knowledge Base of over 14,000 technical documents or download reference
documents, including the Read This First.
Customer Support Guide and Contact Support are available at the My eSupport

page. For information on FlexNet Publisher diagnostic environment variables,
consult the FlexNet Publisher License Administration Guide.
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This appendix provides an overview of Creo View preferences, including
disabling default commands. It describes the locations for preference files and
their hierarchy. Instructions for locking preferences and setting server preferences
are also included.
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Overview of Creo View Preferences
This section contains an overview of the types of preferences you can set for Creo
View. It also provides information for locking preferences.
Types of Preferences
There are five types of preferences. Each type is read from an XML file:
Type
Default

File Name
ProductView_
prefs.xml

Server

server_prefs.xml

Shared

shared_pref.xml
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Location
Read from <Creo
View>\
preferences\
ProductView\
subdirectory of the
installation directory.
Note
A preference sample
file is located
in<Creo View>\
resources\
ProductView\
preferences\
ProductView_
pref.xml
Downloaded from a WVS
Configuration from the
Windchill server context
hierarchy. The server
preferences are only
active when you are
connected to Windchill.
Downloaded from a
shared location, to
<Creo View>\
preferences\
ProductView\
shared_prefs
subdirectory of the
installation directory.
Once enabled, the shared
preference file is updated
automatically. The shared
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Type

File Name

Administrator

admin_prefs.xml

User

user_prefs.xml

Location
preference file is only
active when you are not
connected to Windchill.
Read from <Creo
View>\
preferences\
ProductView\
subdirectory of the
installation directory
Read from the user’s
profile:
• Windows
—%APPDATA%/
ptc/
ProductView/
user_prefs.xml
•

UNIX—$HOME/
.ptc/
ProductView/
user_prefs.xml

The files are processed in the order listed above. You can override a value in a
preference file with a different value in a subsequent file:
•

A user preference replaces the setting for a preference in the administrative
file.

•

An administrative preference replaces the setting for a preference in the server
file. If a shared preference file exists and is active, the administrative
preference replaces the shared preference.

Note
The server preference file and the shared preference file cannot coexist.
For example, the administrator disables the color highlighting command by
defining the highlight_using_color preference in the admin_
prefs.xml file, as shown:
<?xml version="1.0" encoding="utf-8"?>
<preferences>
<category name="General">
<subcategory name="Navigation" >
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<preference1 name="highlight_using_color" value="False"/>
</subcategory>
</category>
</preferences>

However, if the user explicitly enables the same preference in the user interface,
the setting is saved to the user_prefs.xml file. As a result, the administrator
preference is overridden and the color highlighting command is enabled. To
prevent a user from overriding the administrator preferences, lock the
administrator preferences. Continue to the next section, Locking Preferences, for
more information.
Locking Preferences
At any level, you can lock a preference. A locked preference cannot be modified
or overridden by a file on a lower level. Using the color highlighting example
from the previous section, you can add the attribute locked=”True” to prevent
the user from changing the preference:
<?xml version="1.0" encoding="utf-8"?>
<preferences>
<category name="General">
<subcategory name="Navigation" >
<preference1 name="highlight_using_color" value="False" locked="True"/>
</subcategory>
</category>
</preferences

The color highlighting command is now disabled and locked.

Setting Preferences
Set the user preferences using the Creo View Options dialog box in the Creo View
client, and then click OK. For more information, see the Creo View Help.
Set the administrator preferences, server preferences, or both by basing them on
one of these files:
•

User preferences

•

Default preferences

Instructions for both methods follow.
Basing the Administrator or Server Preferences on the User
Preference File
1. In the Creo View client, click File ▶ Options. The Creo View Options dialog
box opens.
2. Set one or more preferences, click OK, and then close Creo View. The changes
are saved to the user_prefs.xml file.
3. Open these files in a text editor:
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•

user_prefs.xml

•

admin_prefs.xml or server_prefs.xml

4. In user_prefs.xml, find and copy the entries for the preferences you set
in step 2.
5. Paste the entries in admin_prefs.xml or server_prefs.xml.

Note
Make sure the XML structure hierarchy is maintained.
6. To lock one or more preferences, add the attribute locked=”True” to the
definition of those preferences.

Note
The locked attribute is not supported in the user_prefs.xml.
7. Save and close admin_prefs.xml or server_prefs.xml.
Basing the Administrator or Server Preferences on the Default
Preference File
1. Make a copy of the default preferences file, ProductView_prefs.xml.
2. Open ProductView_prefs.xml in a text editor.
3. Modify one or more preferences.
4. To lock one or more preferences, add the attribute locked=”True” to the
definition of those preferences.
5. Save the file as admin_prefs.xml or server_prefs.xml, and then
close it.Save the file as admin_prefs.xml
You have now set and locked the administrator or server preferences:
•

For information about using the preference file to disable default commands,
continue to the next section, Disabling Commands.

•

To implement your server preferences, skip to Uploading Server Preferences
to Windchill.
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Disabling Commands
Each control in the user interface has a unique command. For example, the
command for the Print button is PrintCmd. You can use a preference file to
disable access from the user interface to one or more commands on buttons or
ribbons. You cannot disable commands on shortcut menus. Instructions for finding
and disabling a command follow.
Finding a Command
1. To find a command for a button, set the following environment variable:
set PVIEW_DISPLAY_COMMANDS=1

2. Open Creo View, and then place the pointer over the button. A tooltip appears
with the command. For example, PrintCmd.
Using the Preference File to Disable the Command
Follow the instructions in this procedure to disable the Print button.
1. Open admin_prefs.xml or server_prefs.xml in a text editor.
2. At the end of the file, add the following section:
<preferences>
<category name="General">
<subcategory name="UI_Config">
<preference name="disabled_commands" value="PrintCmd"/>
</subcategory>
</category>
</preferences>

3. To disable more than one command, list them, separated by commas, as the
value for disabled_commands.
4. Save admin_prefs.xml or server_prefs.xml and close the file.
The command is now disabled. When all of the preference files are read, the
values in each disabled_commands section are cumulatively disabled.
Some server preference options cannot be configured using the preference editor,
and they only apply when Creo View is embedded in a web page. This option
disables the automatic unlock of an annotation set when closed:
<?xml version="1.0" encoding="utf-8"?>
<preferences>
<category name="Annotations">
<preference name="disable_auto_lock" value="True"/>
</category>
</preferences>
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Uploading Server Preferences to
Windchill
By following the steps in the previous section, you have now created a server
preference file. Follow the next steps to upload the preferences to your Windchill
server:
1. On the Windchill home page, on the left, click Browse. The left frame opens.
2. Select the Browse tab, and then click the Site button.
3. Under Site, click Utilities. The Utilities page opens.
4. Under Business Administration, click Visualization Configuration
Administration. The Creo View Configurations for Site window opens.
5. Click Create configuration, and then upload server_prefs.xml.
6. To the same WVS Configuration, upload any files referenced in server_
prefs.xml, such as these:
•

Watermarks

•

*.ini

•

HPGL pen maps

7. Click Close. Your preferences are uploaded. For more information on
uploading preferences, see the Windchill Help.
You have now implemented your server preferences on Windchill.

Loading Preferences from a Shared
Location
You can centrally manage Creo View preferences. The preferences are stored in a
shared location, and they are copied to the user’s computer. Shared preferences are
available even when the user disconnects from the shared location. The shared
preferences are saved as a ZIP file that contains shared_prefs.xml and any
other required files. Users can load the shared preferences from one of these
locations. The locations are checked in the order below, and the preferences are
loaded only from the first location where they are found:
1. The HKEY_LOCAL_MACHINE registry entry
2. The HKEY_CURRENT_USER registry entry
3. The PVIEW_SHARED_PREFERENCES environment variable
Configuring Shared Preferences for Cadence Allegro and APD
This section describes how you can open Cadence Allegro and APD design files
with no local Allegro installation.
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To configure shared preferences for Cadence Allegro and APD follow the steps
below:
1. In the Creo View client, click File ▶ Options. The Creo View Options dialog
box opens.
2. Set one or more preferences and then click OK. The changes are saved to the
user_prefs.xml file.
3. Open the user_prefs.xml file in a text editor. Locate the entries for the
preferences you set in step 2 and copy them into a new file.
4. Save this file as admin_prefs.xml, server_prefs.xml, and
shared_prefs.xml.

Note
The Cadence Allegro extracta file (.acceptedAllegroExtracta),
must be kept in the same location as the admin_prefs.xml, server_
prefs.xml and shared_prefs.xml.
5. To lock one or more preferences, add the attribute locked=”True” to the
definition of those preferences.

Note
The locked attribute is not supported in the user_prefs.xml.
6. Save and close the user_prefs.xml and server_prefs.xml files.
The saved file is copied to the APPDATA% directory and automatically loaded
into the shared_prefs.xml folder.
Shared Location Types
These are examples of the two types of shared locations:
•

File system—s:\shared_prefs\shared_prefs.zip

•

Shared host—\\sharedhost\shared_prefs\shared_prefs.zip

Defining the Location of Shared Preferences Using the Registry
This section contains instructions on how to define in the registry the location for
shared preferences.
To define the location using an environment variable instead, skip ahead to the
next section, Defining the Location of Shared Preferences Using an Environment
Variable.
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Click Start and in the search box, type Regedit.exe and press ENTER. The
Registry Editor page opens. Then, perform one of the operations below:
•

List the shared preference file in the local machine registry:
1. Go to HKEY_LOCAL_MACHINE ▶ SOFTWARE ▶ PTC ▶ ProductView Client.
2. Right-click and choose New ▶ Key. A new key is added under ProductView
Client.
3. On the left pane, under ProductView Client, rename the new key to
shared_preferences and press ENTER. The shared_preferences
key expands.
4. Right-click and choose New ▶ String Value.
5. Name the new value file.
6. Double-click file and under Value data type the name of the shared
preference file, for example \\sharedhost\shared_prefs\
shared_prefs.zip.
7. Click OK.

•

List the shared preference file in the current user registry:
1. Go to HKEY_CURRENT_USER ▶ SOFTWARE ▶ PTC ▶ ProductView Client.
2. Right-click and choose New ▶ Key. A new key is added under ProductView
Client.
3. On the left pane, under ProductView Client, rename the new key to
shared_preferences and press ENTER. The shared_preferences
key expands.
4. Right-click and choose New ▶ String Value.
5. Name the new value file.
6. Double-click file and under Value data, type the name of the shared
preference file. For example, s:\shared_prefs\shared_
prefs.zip.
7. Click OK.

You have now defined a registry key to point to the shared preference file. Skip to
Loading the Shared Preference File for more information about the next steps.
Defining the Location of Shared Preferences Using an Environment
Variable
This section contains the procedure for creating an environment variable that
points to the shared preference file.
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1. Click Start, and in the search box, type environment and press ENTER. The
Environment Variables page opens.
2. Under User variables for <your user name>, click New. The New User Variable
dialog box opens.
3. Under Variable name, type PVIEW_SHARED_PREFERENCES.
4. Under Variable value, type the name of the shared preference file, for example
\\sharedhost\shared_prefs\shared_prefs.zip, and click OK.
5. In the Environment Variables dialog box, click OK to close the dialog box.
You have now set an environment variable to point to the shared preference file.
Continue to the next section, Loading the Shared Preference File
Loading the Shared Preference File
After you configure shared preferences, the preferences are automatically loaded
and updated in Creo View. The shared file is copied to the user’s %APPDATA%
directory. It is placed in the designated folder, shared_prefs. When the user
starts Creo View, the local copy and the shared file are compared and the local file
is updated. For example, if a user has manually modified the XML file for the
preferences, these changes are overwritten by the shared preferences file.
If the shared file is missing from the %APPDATA% directory, and the shared
location is not found, the user cannot start Creo View at all. To fix the problem, do
one of these operations:
•

Reconnect to the shared location

•

Remove the registry setting or environment variable that points to the shared
location

Disabling Shared Preferences
To disable shared preferences, delete the environment variable or the registry
entries you added in Defining the Location of Shared Preferences Using the
Registry or Defining the Location of Shared Preferences Using an Environment
Variable.
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This appendix provides instructions to configure and customize the Creo View
ribbon commands.
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Overview of Ribbon Customizing
This section contains an overview of customizing the availability of Creo View
ribbon commands.
Configure which Creo View user interface commands are available and save them
in the Creo UI Toolkit *.ui files.

Setting Preferences
The customized user interface definitions are saved in proprietary Creo UI Toolkit
files (*.ui) created in the %APPDATA%\PTC\ProductView folder. There are
two customization files: an optional administrator file and the user file. The
administrator file is loaded first. It defines the baseline for user customization.
Set the user preferences using the Customize Ribbon page. Access the dialog box
from the Creo View Options in the Creo View client. For more information, see
About Customizing the Ribbon in the Creo View Help.

Customizing and Saving the Ribbon
Locally
1. In Windchill, click Product ▶ Utilities ▶ Visualization Configuration
Administration and upload the uiconfig.xml file and the referenced image
files. (These can have PNG, BMP, JPG, or JPEG format extensions.)
2. Open a file in Creo View.
3. Use the Customize Ribbon page of the Creo View Options dialog box to make
changes to the ribbon.
4. Click Apply, and then click OK to add the newly created menu.
5. The new menu appears in the ribbon menu and the customized commands
appear in that menu.
6. Exit Creo View and navigate to the %APPDATA%\PTC\ProductView
folder. Note that the following files are present in that directory:
•

user_prefs.xml

•

user_cust_pvpro.ui

7. Rename the above two files as follows:
•

server_prefs.xml

•

server_cust_pvpro.ui

8. Edit server_prefs.xml and add the following preference:
<?xml version="1.0" encoding="utf-8"?>
<preferences>
<category name="GUI">
<category name="Customize">
<preference name="Location" value="server"/>
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</category>
</category>
<preferences>

9. Save and exit the editor.
10. Zip these files:
•

uiconfig.xml

•

server_prefs.xml

•

server_cust_pvpro.ui

•

The referenced image files

You have now customized the ribbon menu. To implement your preferences,
continue to Uploading the Customized Files to Windchill.

Uploading the Customized Files to
Windchill
By following the steps in the previous section, you have created a customized
ribbon file. Follow the next steps to upload the preferences to your Windchill
server.
1. In Windchill, navigate to the Product ▶ Utilities ▶ Visualization Configuration
Administration page.
2. Click Create configuration, and then upload the zip files you created.

Note
If there are previously uploaded uiconfig.xml and referenced image
files, delete them before uploading.
3. Clear the Creo View cache (%APPDATA%\PTC\ProductView).
4. Open a structure in Creo View from Windchill to validate that the customized
menu appears in the ribbon menu.
5. Click Close. Your preferences are uploaded. For more information on
uploading preferences, see the Windchill Help.
You have now implemented your server preferences on Windchill. The
customized menu should appear in the ribbon menu for all Windchill users who
are accessing the object from within the configured context.

Customized Ribbon Preferences
This section contains the GUI/Customize/ preferences you can set for Creo
View. Add the preferences manually to the XML file. The preference name
defines the hierarchy for XML preference category elements.
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Location
This preference defines the source of the admin ribbon customization file.
•

admin—The source is the same directory as the admin preferences XML
file.

•

server—The source is the same Windchill location as the server preferences
XML file.

•

shared—The source is the same location as shared cache preferences XML
file.

AllowCustomize
This preference controls whether the user can customize his ribbon. It does not
stop any existing customization from being applied, but prevents changing the
customization.

Note
The Quick Access Toolbar is not disabled together with the Customize Ribbon
option.
The value can be true or false. If false, customization of the ribbon is
disabled.
RemoveInvisibleFromQAT
This preference controls visibility of the Quick Access Toolbar buttons that have
been removed from the ribbon. You can set this value to prevent buttons that are
not available in the ribbon due to customization from appearing in the Quick
Access Toolbar options page.
The value can be true or false. If true, buttons removed from the ribbon do
not appear in Quick Access Toolbar options page.
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F
Creating Annotation Templates

This appendix describes how to create an Annotation Template XML document.
About Annotation Templates
An Annotation Template is a set of annotation properties and values that can be
applied during an edit. Annotation templates make it easy to apply a standard
annotation style across a design.
Use a text editor to create and edit annotation templates. Once imported, the
annotation templates will then be available for use when editing annotations in
Creo View.
Annotation templates can be used to define the following properties:
•

Text content of a label

•

Expanded text option of a label

•

Font size of a label

•

Color of any annotation

•

Background color for a label or any shape

•

Line width of a leader line or freehand

•

Transparency of any shape

•

Line style of a leader line, freehand, or polygon

•

Lock-on-zoom property of a note

•

Shape of a label
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About the Annotation Template XML Document
The element <annotationtemplates> can contain a number of different
templates.
The file may also contain a name attribute. Use the name attribute to distinguish
templates from different files that have the same name.
The element <annotationtemplate> contains <template> tags. Each
<template> tag defines a single annotation template.
The <template> tag contains the following information:
•

An attribute name which defines the annotation template name

•

A list of <property> tags that define template properties in the template:
○ type—Defines the type of property, for example line style or
transparency.
○ value—Sets the value of the property
○ appliesto—Applies the template to certain annotation types

<type> Element
The <type> element defines type of property. Define the type of property by
setting the <values> for one or more of the following:
Property Type
text

Values
text

textexpanded
fontsize
shape

true, false
real value
circle, square,
rectangle,
hexagon,
triangleup,
triangledown,
roundedrectangle
hexadecimal color
value
hexadecimal color
value
any integer

color
backgroundcolor
linewidth

linestyle
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solid, dotdash,
dotdotdash

Description
Text content for a note
without attributes.
Expanded Text option
Font size in points
Shape of the note.

The line widths selectable
interactively corresponds
to 1, 3, 5
One of the literal values
shown, corresponding to
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Property Type

fillstyle

lockonzoom

Values

Description
the line styles available
when editing interactively
in Creo View.
none, transparent, One of the literal values
opaque
shown, corresponding to
the transparency values
available when editing
interactively in Creo
View.
true, false

<appliesto> Attribute
The attribute <appliesto> defines which types of annotation the property
should be applied to. For example, use this attribute to define a different color for
a note and a leader line separately. The value of the <appliesto> attribute is a
comma-separated list of one or more of the following values:
•

all

•

note

•

leaderline

•

freehand

•

rectangle

•

ellipse

•

polygon — Surface polygon in 3D and a 2D polygon

Annotation Template XML Document Example
Below is an example of an Annotation Template file. The file contains three
individual templates: Critical Surface Polygon, Needs Review Note
and Blue Ellipse.
<annotationtemplates name="examples">
<template name="CriticalSurfacePolygon">
<property appliesto="note" value="CriticalSurface" type="text"/>
<property appliesto="note,polygon,leaderline" value="ff0000" type=
"color"/>
<property appliesto="polygon,leaderline" value="dotdash" type=
"linestyle"/>
<property appliesto="polygon" value="opaque" type="fillstyle"/>
<property appliesto="note" value="a0a0a0" type="backgroundcolor"/>
</template>
<template name="NeedsReviewNote">
<property appliesto="note" type="text">
<textsegment value="Component" type="text"/>
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<textsegment value="_PV_SystemProperties.Component Name.Value"
type="attribute"/>
<textsegment value="needs review" type="text"/>
</property>
<property appliesto="note" value="ff0000" type="color"/>
<property appliesto="leaderline" value="00000" type="color"/>
<property appliesto="note" value="8" type="fontsize"/>
<property appliesto="leaderline" value="3" type="linewidth"/>
<property appliesto="note" value="roundedrectangle" type="shape"/>
<property appliesto="note" value="true" type="textexpanded"/>
</template>
<template name="BlueEllipse">
<property appliesto="ellipse" value="0000ff" type="color"/>
<property appliesto="ellipse" value="opaque" type="fillstyle"/>
</template>
</annotationtemplates>
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Customizing Lighting Setups
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About the Light Scenes XML Document ......................................................................94
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This appendix describes the structure, elements, and attributes of the Light Scenes
XML document. (For the XML document schema, see the separate appendix,
Lighting Setups XML Document Schema.)
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About Customizing Lighting Setups
Lighting setups in the Creo View Lights list are encoded the Light Scenes XML
document. Creo View uses the Light Scenes XML document stored in this XML
text file:
%APPDATA%\ptc\ProductView\LightScenes.xml.
You can edit this file to change or delete lighting setups in the Lighting Setup list.
(To open the list in Creo View, click the ribbon Figure tab, and then click the
Lighting Setup box in the Lights group.) Lighting setups include properties for
light type, color, and direction. To update the Lighting Setup list after you edit the
XML file, place a copy of the updated file in
%APPDATA%\ptc\ProductView\LightScenes.xml
and then restart Creo View.

About the Light Scenes XML Document
The main elements in the Light Scenes XML document are summarized below.
All elements and attributes in the XML document are specified separately in the
topics that follow.
About Element and Attribute Types in the Light Scenes XML
Document
All elements and attributes are the String data type unless their descriptions in this
appendix starts with Mixed, Boolean, or Restricted in parentheses as shown
below.
•

(Mixed) elements can contain both text and other elements.

•

(Boolean) attributes can only be set true or false.

•

(Restricted) attributes can only be set to the values enumerated in their
description.

In addition, all attributes are required unless their description in this appendix
starts with (Optional).
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Main Elements in the Light Scenes XML Document
<lightscenes>

<lightscene>
<name>

<light>

Lighting setup list element. Contains one <lightscene>
element for each lighting setup in the list. (See <lightscenes>
Element.)
Lighting setup element. Contains the properties for one
lighting setup. (See <lightscene> Element.)
Lighting setup name element. Can contain one of three
localized predefined names or a custom name. (See <name>
Element.)
Lighting element. Defines the type, color, and direction for
one light in a lighting setup. A lighting setup
(<lightscene> element) contains one or more lights
(<light> elements). (See <light> Element.)

Structure of the Light Scenes XML Document
<?xml version="1.0" encoding="UTF-8"?>
<lightscenes>
<lightscene>
<name />
<light>
<color />
<position />
<direction />
<angle></angle>
<exponent></exponent>
</light>
…
<light />
<light />
</lightscene>
<lightscene />
…
</lightscene />
</lightscenes>
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<lightscenes> Element
The <lightscenes> element defines all lighting setups in the Creo View
Lighting Setup list. It contains one or more child <lightscene> elements. The
<lightscenes> element has no attributes. An XML file can contain only one
<lightscenes> element.
<lightscenes> Syntax
<lightscenes>
<lightscene />
<lightscene />
…
<lightscene />
</lightscenes>

<lightscenes> Child Elements
<lightscene>

Lighting setup element. Contains the properties for one
lighting setup. (See <lightscene> Element.)

<lightscenes> Example
The <lightscenes> element below creates two lighting setups in the Lighting
Setup list:
•

DEFSingle—A single-light setup with one key light and a predefined
localized name.

•

TwoLights—A two-light setup with one key light and one fill light and a
custom non-localized name.

<lightscenes>
<lightscene>
<name locid="DEFSingle"/>
<light name="key" type="direct" relative="view" />
<color />
<direction />
</lightscene>
<lightscene>
<name>TwoLights</name>
<light name="key" type="direct" relative="view" />
<color />
<direction />
<light name="fill" type="direct" relative="view" />
<color />
<direction />
</lightscene>
</lightscenes>
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<lightscene> Element
The <lightscene> element is a child of the <lightscenes> element. Each
<lightscene> element encodes the properties for one lighting setup containing
one or more lights (<light> elements).
Each <lightscene> element has a unique name defined in its <name>
element. The <name> element can contain an optional predefined localized
lighting setup name or a custom name.
The <lightscenes> element has no attributes.
<lightscene> Syntax
Example: Lighting setup with a predefined localized name:
<!-- Lighting setup with a predefined localized name -->
<lightscene>
<name locid="DEFlocName"/>
<light />
<light />
…
<light />
</lightscene>

Example: Lighting setup with a custom non-localized name:
<!-- Lighting setup with a custom non-localized name -->
<lightscene>
<name>Lighting Setup Name</name>
<light />
<light />
…
<light />
</lightscene>

<lightscene> Child Elements
<name>
<light>

(Mixed) Specifies the lighting setup name shown in the
Lighting Setup list. (See <name> Element.)
Defines the type, color, and direction for one light in a
lighting setup. A <lightscene> element contains
one or more <light> elements. (See <light>
Element.)

<lightscene> Example
This example shows the predefined lighting setup, DEFTwoLights, encoded in
a <lightscene> element.
<lightscene>
<name locid="DEFTwoLights"/>
<light name="key" type="direct" relative="view">
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<color ambient="#141414" diffuse="#BEBEBE" specular="#CCCCCC"/>
<direction x="-60.00" y="15.00" z="5.00"/>
</light>
<light name="fill" type="direct" relative="view">
<color ambient="#050505" diffuse="#969696" specular="#AFAFAF"/>
<direction x="10.00" y="60.00" z="0.00"/>
</light>
</lightscene>

<name> Element
The <name> element is a child of the <lightscene> element. It contains
either a locid attribute that defines a predefined localized name, or, it contains a
custom name. The <name> element has no child elements.

Note
The Creo View installation includes predefined and localized locid attribute
values for the <name /> child element. These locid values have the prefix
DEF and are reserved by Creo View. Do not edit locid values. Rather, if you
want to change the lighting setup name, replace the self-closing element with
an element of the same name that has a start and an end tag; for example,
<name>My Name</name>. The content of the <name> element, My Name,
overrides the locid value (if present).
<name> Syntax
<!-- Predefined localized name -->
<name locid="DEFlocName"/>
<!-- Custom name -->
<name>Lighting Setup Name</name>
<!-- Custom name overrides predefined name -->
<name locid="DEFlocName">Lighting Setup Name</name>

<name> Attributes
locid
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(String) Optional, unique predefined and localized text for
the lighting setup name. If the <name> element contains
custom name text, the custom name overrides the predefined
name in the locid attribute.
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<name> Example
This example shows a <name> element with a custom name, Key and Fill
Lighting, that overrides the predefined name in the locid attribute,
DEFTwoLights. The Lighting Setup list in Creo View will show Key and Fill
Lighting.
<name locid="DEFTwoLights">Key and Fill Lighting</name>

<light> Element
The <light> element is a child of the <lightscene> element. The
<light> element defines the type, color, and direction for one light in a lighting
setup.
<light> Syntax
<light name="Light Name" type="[direct|spot|point]" relative="[view|scene]">
<color />
<position />
<direction />
<angle>
<exponent>
</light>

<light> Attributes
name
type
relative

(String) Specifies the name of the light.
(String) Specifies the light type as direct (default), spot,
or point.
(String) Specifies whether the light is relative to the view
(default) or the scene.

Note
For orthographic projections, if you set the <light>
attribute type="spot" or type="point", you
should only set the attribute relative="scene".
Setting relative="view" can produce unpredictable
results.
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<light> Child Elements
<color />
<position />

<direction />

<angle>
<exponent>

Specifies the color intensity of the ambient, diffuse, and
specular light settings. (See <color> Element .)
For spot and point lights only—Specifies the XYZ
coordinates for the location of the point or spot light source,
assuming it not infinitely far from the scene. (See <position>
Element .)
For direct and spot lights only—Specifies the XYZ
vector for the direction of the direct or spot light source. (See
<direction> Element .)
For spot lights only—Specifies the cutoff angle for the spot
light source. (See <angle> Element .)
For spot lights only—Specifies the exponent for the spot
light source. (See <exponent> Element .)

<light> Example
This example shows the light element for a spot light source that has a position in
the scene.
<light name="back" type="spot" relative="scene">
<color ambient="#0A0A0A" diffuse="#FFB669" specular="#E0E0E0"/>
<position x="71.00" y="66.00" z="24.00"/>
<direction x="-60.00" y="60.00" z="-20.00"/>
<angle>10.00</angle>
<exponent>128</exponent>
</light>

<color> Element
The <color> element is a child element of <light> that specifies the intensity
of the ambient, diffuse, and specular settings for the RGB hexadecimal color
codes. (The <color> element is self-closing. It has no content or child
elements.)
<color> Syntax
<color ambient="#hexColor" diffuse="#hexColor" specular="#hexColor" />
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<color> Attributes
Specifies the ambient light setting as a RGB
hexadecimal color code. Valid values are #000000
to #FFFFFF. This attribute value corresponds to the
Ambient setting in the Custom lighting setup dialog
box.
Specifies the diffuse light setting as a RGB
hexadecimal color code. Valid values are #000000
to #FFFFFF. This attribute value corresponds to the
Diffuse setting in the Custom lighting setup dialog
box.
Specifies the specular light setting as a RGB
hexadecimal color code. Valid values are #000000
to #FFFFFF. This attribute value corresponds to the
Specular setting in the Custom lighting setup dialog
box.

ambient

diffuse

specular

<color> Example
<color ambient="#333333" diffuse="#CCCCCC" specular="#CCCCCC"/>

<position> Element
The <position> element is a child element of <light> for spot and point
lights only. It specifies the XYZ coordinates for the location of the point or spot
light source that is not infinitely far from the scene. If the <position> element
is omitted, the point or spot light source is considered infinitely far away; i.e., rays
of light from the source are considered parallel.
The <position> element is self-closing. It has no content or child elements.
<position> Syntax
<position x="xValue" y="yValue" z="zValue" />

<position> Attributes
xyz

(Float) Specifies the ±(X, Y, or Z) coordinate for the point or
spot light source location.

<position> Example
This example shows a <position> element for the XYZ location (-150, 150,
600).
<position x="-150.00" y="150.00" z="600.00" />
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<direction> Element
The <direction> element is a child element of <light> for direct and
spot lights only. It determines the axis of the cone of light for the light source.
The XYZ vector coordinates are taken relative to the origin at the vertex of the
light cone.
(The <direction> element is self-closing. It has no content or child elements.)
<direction> Syntax
<direction x="xValue" y="yValue" z="zValue" />

<direction> Attributes
xyz

(Float) Specifies the ±(X, Y, or Z) coordinate for the
direction vector along the axis of the direct or spot light.

<direction> Example
This example shows a <direction> element with the XYZ vector coordinates
(-60, 60, -20).
<direction x="-60.00" y="60.00" z="-20.00"/>

<angle> Element
The <angle> element is a child element of <light> for spot lights only. It
specifies the cutoff angle in positive degrees from 0.00 to 180.00 as Float. The
cutoff angle is the angle between the axis of the light cone and a ray along the
edge of the cone.
<angle> Syntax
<angle>degValue</angle>

<angle> Example
This example shows an <angle> element with a cutoff angle of 10 degrees.
<angle>10.00</angle>

<exponent> Element
The <exponent> element is a child element of <light> for spot lights only.
It specifies the exponent for the spot light source as a positive whole number from
0 (default) to 128 as Integer. Increase the exponent value to increase the focus or
to concentrate the spot light source.
<exponent> Syntax
<exponent>expValue</exponent>
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<exponent> Example
This example shows an <exponent> element with a exponent value of 128.
<exponent>128</exponent>
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Light Scenes XML Document Examples
Light Scenes XML Document As Installed
The installed version of the Light Scenes XML document in
LightScenes.xml is listed below. It contains three predefined lighting setups
that appear on the Lighting Setup list in Creo View: DEFSingle (Single Light),
DEFTwoLights (2 Lights), and DEFThreeLights (3 Lights).
<?xml version="1.0" encoding="UTF-8"?>
<lightscenes>
<lightscene>
<name locid="DEFSingle"/>
<light name="key" type="direct" relative="view">
<color ambient="#3C3C3C" diffuse="#BABABA" specular="#DCDCDC"/>
<direction x="-60.00" y="15.00" z="5.00"/>
</light>
</lightscene>
<lightscene>
<name locid="DEFTwoLights"/>
<light name="key" type="direct" relative="view">
<color ambient="#141414" diffuse="#BEBEBE" specular="#CCCCCC"/>
<direction x="-60.00" y="15.00" z="5.00"/>
</light>
<light name="fill" type="direct" relative="view">
<color ambient="#050505" diffuse="#969696" specular="#AFAFAF"/>
<direction x="10.00" y="60.00" z="0.00"/>
</light>
</lightscene>
<lightscene>
<name locid="DEFThreeLights"/>
<light name="key" type="direct" relative="view">
<color ambient="#0A0A0A" diffuse="#B4B4B4" specular="#E0E0E0"/>
<direction x="-60.00" y="15.00" z="5.00"/>
</light>
<light name="fill" type="direct" relative="view">
<color ambient="#0A0A0A" diffuse="#CCCCCC" specular="#CCCCCC"/>
<direction x="10.00" y="60.00" z="0.00"/>
</light>
<light name="back" type="direct" relative="view">
<color ambient="#0A0A0A" diffuse="#CCCCCC" specular="#CCCCCC"/>
<direction x="320.00" y="190.00" z="125.00"/>
</light>
</lightscene>
</lightscenes>
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Light Scenes XML Document with All Light Types
The following XML document shows a 3-light lighting setup with definitions for
all light types; direct, point, spot
<?xml version="1.0" encoding="UTF-8"?>
<lightscenes>
<lightscene>
<name locid="DEFThreeLights">Three Light Setup</name>
<light name="key" type="direct" relative="view">
<color ambient="#333333" diffuse="#CCCCCC" specular="#CCCCCC"/>
<direction x="-60.00" y="-16.10" z="9.34"/>
</light>
<light name="fill" type="point" relative="scene">
<color ambient="#333333" diffuse="#CCCCCC" specular="#CCCCCC"/>
<position x="-150.00" y="150.00" z="600.00"/>
</light>
<light name="back" type="spot" relative="scene">
<color ambient="#0A0A0A" diffuse="#ffb669" specular="#E0E0E0"/>
<position x="71.00" y="66.00" z="24.00"/>
<direction x="-60.00" y="60.00" z="-20.00"/>
<angle>10.00</angle>
<exponent>128</exponent>
</light>
</lightscene>
</lightscenes>

Customizing Lighting Setups
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This appendix lists the XML schema for the lighting setups XML document used
in Creo View.
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About the XML Schema
The XML schema listed below defines the following characteristics of the Light
Scenes XML document:
•

Elements and attributes that can appear in the document, along with their data
types and values

•

Which elements are child elements, and the order and number of child
elements

•

Whether an element is empty or can include text

Any custom Light Scenes XML files that you intend to use with Creo View must
follow this schema.

Note
For more information on the Light Scenes XML Document, see Customizing
Lighting Setups.
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XML Schema Listing
<?xml version="1.0" encoding="utf-16"?>
<xsd:schema attributeFormDefault="unqualified" elementFormDefault="qualified"
version="1.0" xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<xsd:element name="lightscenes">
<xsd:complexType>
<xsd:sequence>
<xsd:element maxOccurs="unbounded" name="lightscene">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="name">
<xsd:complexType>
<xsd:attribute name="locid" type="xsd:string" />
</xsd:complexType>
</xsd:element>
<xsd:element name="light">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="color">
<xsd:complexType>
<xsd:attribute name="ambient" type="xsd:string" />
<xsd:attribute name="diffuse" type="xsd:string" />
<xsd:attribute name="specular" type="xsd:string" />
</xsd:complexType>
</xsd:element>
<xsd:element name="direction">
<xsd:complexType>
<xsd:attribute name="x" type="xsd:decimal" />
<xsd:attribute name="y" type="xsd:decimal" />
<xsd:attribute name="z" type="xsd:decimal" />
</xsd:complexType>
</xsd:element>
</xsd:sequence>
<xsd:attribute name="name" type="xsd:string" />
<xsd:attribute name="type" type="xsd:string" />
<xsd:attribute name="relative" type="xsd:string" />
</xsd:complexType>
</xsd:element>
</xsd:sequence>
</xsd:complexType>
</xsd:element>
</xsd:sequence>
</xsd:complexType>
</xsd:element>
</xsd:schema>
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This appendix provides instructions on how to configure your computer to support
the stereoscopic view provided by Creo View.
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Hardware Prerequisites
For a personal computer:
•

NVIDIA 3D display card with 3D vision compatible display

•

Compatible shutter glasses

For a television set:
•

NVIDIA 3D display card with a 3D television set

•

Compatible polarizing glasses

Configuring the NVIDIA Hardware
1. Click
, type nvidia and press ENTER. The NVIDIA Control Panel dialog
box opens.
2. On the left, under Stereoscopic 3D, click Set up stereoscopic 3D. The Set Up
Stereoscopic 3D opens.
3. Select Enable stereoscopic 3D.
4. Verify that Select when the display is in 3D mode is set to Always.
5. To avoid the flickering effect, verify that you are not using a multiplication of
the frequency of your screen. For example, if your screen frequency is set to
50Hz, use 120 Hz.

Note
For some 3D displays, you might need to use a specific resolution. For
example, if you are using a 3D television set, you must set its resolution to
1080p, 1920*1080.
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This appendix provides instructions on how to edit customized commands in Creo
View.
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About Customized Commands
You can create customized commands in Creo View. From the Creo View
Options, under Customize, select the Custom Commands and click Add to add a
new command or Edit to edit an existing command.
You can later add these commands to the Ribbon or to the Quick Access Toolbar.
Adding the command to the right-click menu is done via the command definition
as described below.
Using customized commands, you can define one of the following three
behaviors:
•

Save the current view to an annotation set (defined by XML attributes).

•

Copy the image in the view by adding it to the clipboard (defined by XML
attributes).

•

Open a URL in a web browser and define substitutions for properties (defined
by XML content).

About the Command Definition XML Code
Each customized command you define has its own Command Definition. The main
elements are summarized below. All elements and attributes are specified in the
topics that follow.
About Element and Attribute Types in the Command Definition XML
Code
All elements and attributes are the String data type unless their descriptions in this
appendix starts with Mixed or Boolean in parentheses as shown below.
•

(Mixed) elements can contain both text and other elements.

•

(Boolean) attributes can only be set true or false.

Available Elements in the Customized Command Definition XML
<menu>
<command_
name>
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(Mixed) Mandatory menu setup element. This is the root
element. (See The <menu> Element Attributes on page 116.)
Mandatory command name element. Specifies the unique
name of this customized command. You can use this
identifier as a reference in the Ribbon or when you override
the command. In addition, this is the identifier you specify
when you define the position of another customized
command in the right-click menu.
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<locked>

<label>
<tooltip>
<icon>

<icon_large>

<action>

<rmb_order>

(Boolean) Optional locked element. Specifies whether this
command can be edited or deleted by any user. This option
applies only if this is not a user XML file.
Mandatory label element. Specifies the command’s label on
the Ribbon and the right-click menus.
Optional tooltip element. Specifies the command’s tooltip.
Optional icon element. Specifies the 16*16 icon. The icon
file must reside on the same folder as the XML file. The
recommended format is PNG.
Optional icon element. Specifies the 32*32 icon. The icon
file must reside on the same folder as the XML file. The
recommended format is PNG.
(Mixed) Option action element. Specifies the action
performed with this command. Uses XML attributes to save
a view to an annotation set or copy an image to the
clipboard. Uses XML content to open a URL. (See The
<action> Element Attributes on page 117.)
(Mixed) Optional right-click menu order element. Specifies
the position of the customized command in the right-click
menu. If you do not define this element, Creo View adds
customized commands to the right-click menu in
alphabetical order. (See <rmb_order> Element Attributes on
page 119.)

Structure of the Customized Command XML
<menu
...>
<command_name>MyCommand 1</command_name>
<locked>true</locked>
<label>Button Label</label>
<tooltip>Button tooltip</tooltip>
<icon>\my\icons\location\icon16x16.png</icon>
<icon_large>\my\icons\location\icon32x32.png</icon_large>
<action>
...
</action>
<rmb_order
name="AnotherCommand"
position="before">
</rmb_order>
</menu>
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The <menu> Element Attributes
ui

view

pane

menus

select

visible

Specifies the location where the action will take place. The
available options are ribbon and rmb. If you omit this
option, the command will be available from both the Ribbon
and the right-click menu.
Specifies the objects on which the action can take place in
the user interface. The options are 2d (2D object), 3d (3D
object), image, doc , all, and none. You can specify one
of the options or an OR list of these options. For example,
view="2d|3d".
Specifies a set of panes where the action will take place in
the user interface. The options are file, landmark,
tree, viewContentPane, all and none. You can
specify one of the options or an OR list of these options. For
example, pane="file|landmark". The default value is
all.
Specifies the menus and the context menus that this option
will be added to. (See Available Values for the menus
Attribute on page 116.)
Specifies the number of the selected objects required to
activate this action. The available options are 0, 1, any, and
many.
Specifies a set of filter conditions using the functions listed
below. Each function returns a boolean value that can be
used to specify the filter conditions. You can specify more
than one function by using the AND operator (&amp;) . (See
Available Functions for the visible Attribute on page 117.)

Available Values for the menus Attribute
pvgroupspa
Adds the commands to the Groups pane menu.
ne1.ProGroup
sMenu
pvgroupspa
Adds the commands to the Group Content pane menu.
ne1.ProGroups
ContentsMenu
pvresultspa
Adds the commands to the Search Results list menu.
ne.ResultsMe
nu
pvmodelannota Adds the commands to the Model Annotations menu.
tionspane.Mo
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delAnnotation
sMenu
pvlayerspane.
LayerGroupsMe
nu
pvlayerspane.
LayersMenu
pvproppaneme
nu.PropDlgMe
nu
pvlayers2dpa
ne.Layer2DMe
nu
pvblocks2dpa
ne.Block2DMe
nu

Adds the commands under the Layers pane, to the Group list
menu.
Adds the commands under the Layers pane, to the Layer list
menu.
Adds the commands to the Attributes pane menu.
Adds the commands to the Layers pane, for the drawings
menu.
Blocks pane for drawings menu.

Available Functions for the visible Attribute
getSelected
Returns true if the number of selected parts is "greater
Count ">" or
than", or "equal to", or "greater than or equal to" the
"==" or ">="
specified number.
number
getPropertyEx Returns true if in the first selected item, the property
ists
exists. Since there is no ordering of selection, it is useful
('DESCRIP
with a single selection.
TION')
getSelected
Returns true if it successfully managed to retrieve the
PartProper
property defined in <property name> of the selected
ty(<selection part. The part is defined according to the order of the
index>,<prop selection, specified in <selection index>. The value
erty name>,
retrieved is assigned to the URL substring marked
<string>)
<string>, according to the XML content.

The <action> Element Attributes
target

Specifies the location where the action will take place. The
available option is browser.

saveViewToAnnoSpecifies that if the current view is an annotation set, the
Set
annotation set is saved, if the value is set to true. If the
value is set to false, the current view is not saved. If
annoSetNameSeed is defined, a new annotation set is
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created and named according to the values of
annoSetNameSeed, annoSetNameSuffixUser, and
annoSetNameSuffixDate.
annoSetNameSeed

Specifies a name for the annotation set. Together with
annoSetNameSeed and annoSetNameSuffixUser,
the annotation set name is unique.

annoSetNameSufAppends the current user's name to the name of the
fixUser
automatically created annotation set, if the value is set to
true.
annoSetNameSufAppends the current date to the name of the automatically
fixDate
created annotation set, if the value is set to true.

Note
If annoSetNameSuffixUser is set to true then the
current date is appended after the user name.
copyViewToClipCopies the current view to the clipboard, if the value is set to
board
true. If the view state is an annotation set, then the link and
image are both copied. If you paste the contents in Microsoft
Excel, Microsoft PowerPoint, or Microsoft Word and click
the image link, Creo View opens in the corresponding web
page and displays the annotation set as the first page.

Note
Creo View will only open if you are running with
Windchill.

The Content of the <action> Element
The content of the <action> element defines which URL to open and how. When
the content is a URL:
•

If you are using a web toolkit to build your server, the window will open from
the web browser that Windchill is running in.

•

Otherwise, the window will open in the default web browser.

In addition, you can also provide substitutions for properties to edit the URL. Creo
View searches the property you list in the element content and replaces its value to
create a new URL.
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Example: Opening a Standard URL
<action
target="browser">
http://somewhere.com
</action>

In this case, the web browser opens www.somewhere.com.
Example: Opening a URL with Substitutions
<action
target="browser">
http://somewhere.com/content.jsp?material=&lt;!MATERIAL!&gt;
</action>

In this case, if the selected item has a property called MATERIAL and its value is
set to steel, it will replace the relevant substring of the URL with the property
value. In this case, the web browser would open http://somewhere.com/
content.jsp?material=steel.

Note
You can define several substitutions in a single URL. Define substitutions by
enclosing the property to be substituted with &lt;! (less than) and !&gt;
(greater than).

<rmb_order> Element Attributes
name
position

Specifies next to which right-click customized command the
new customized command will reside.
Specifies the location of the customized command with
regards to the command specified in the name attribute. The
options are before and after.

Customized Command Definition
Examples
Example: Replacing a Part of the URL Using Property Substitutions
This customized command is labeled Button Label, has a tooltip, etc. In
addition, when this command is activated, it checks the currently selected part for
a specified property (Source_file_name). If it does not find it, the button is
not enabled. If it finds it, it replaces the substring in the URL.
<menu
ui="rmb"
view="all"
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pane="all"
select="any"
visible="getSelectedCount()==1 &amp;&amp; getPropertyExists(&apos;
Source_file_name&apos;)">
<command_name >MyCommand 1</command_name>
<label >Button Label</label>
<tooltip>This is a new command.</tooltip>
<icon>\my\icons\location\icon16x16.png</icon>
<action
target="browser">
http://somewhere.com/content.jsp?partName=&lt;!Source_file_name!
&gt;
</action>
</menu>

Example: Replacing a Part of the URL when Multiple Parts are
Selected
In this example, when the user selects two parts, Creo View fetches the values of
the Featrue_Id property of both parts, returned from
getSelectedPartProperty. It then replaces two substrings of the URL
with these values.
<menu
ui="rmb"
view="all"
pane="all"
select="any"
visible="getSelectedCount()==2 &amp;&amp; getSelectedPartProperty
(1,&apos;Feature_Id&apos;,&apos;featureId1&apos;) &amp;&amp;
getSelectedPartProperty(2,&apos;Feature_Id&apos;,&apos;featureId2&apos;)">
<command_name >MyCommand 2</command_name>
<label >Button Label</label>
<action
target="browser">
http://www.somewhere.com/index.jsp?Id1=&lt;!featureId1!&gt;&amp;
Id2=&lt;!featureId2!&gt;
</action>
</menu>
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